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Resumo

Foi feito um estudo sobre antenas RFID, uma tecnologia que vem se desenvolvendo
rapidamente nos ultimos anos. Conhecidos os problemas da tecnologia, como o rapido
decaimento do sinal e erros de leitura quando muitas tags estdo juntas ou em
orientacdes aleatorias, propde-se 0 uso de lentes conhecidas como metamateriais para
amplificar e focalizar o sinal enviado pela antena transmissora. Tais lentes foram
otimizadas para operar na faixa de frequéncia de RFID (860 MHz — 960 MHz).

Palavras-chave: Metamaterial, Tags RFID.
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LENSES BASED ON METAMATERIALS
FOR RFID ANTENNAS

Abstract

This work concerns the design of RFID antennas, a technology hastily developed in the
last years. The main problems on the current RFID systems rely on two classes: a) the
large-signal attenuation (with the distance), and b) the reading errors that occur when
many antennas (tags) are spatially close and with inadequate orientation. This work
introduces metamaterial lenses for enhancing the transmitting antenna gain and
improving the ability to distinguish tags by focalizing the signals. The lenses were
optimized for operating in the RFID frequency band of 860 MHz to 960 MHz.

Keywords: RFID Tags, Metamaterial.
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1 Introducéo

Identificacdo por radiofrequéncia ou RFID (do inglés Radio Frequency
Identification) € uma tecnologia que comecou a ser estudada para modernizar a
tarefa de identificacdo de objeto e produtos sem a necessidade de fios ou de
artificios de identificacdo 6pticos (como aqueles dos cddigos de barras. A tecnologia
de RFID é baseada na leitura e armazenamento de informacdes contidas em
etiquetas compostas por pequenas antenas e transdutores passivos (tags) por meio
dos campos eletromagnéticos.

Este projeto apresenta a caracterizacdo de uma antena RFID presente no
laboratério da universidade, assim como a otimizacdo de lentes de metamaterial
para 0 uso conjunto a antena, buscando melhorias nas quantidades de tags

identificadas e na distancia efetiva da leitura das mesmas.
1.1. Contexto Historico

A tecnologia RFID teve seu inicio nos anos 1940 durante a segunda guerra
mundial [1]. As nacBes em conflito tinham o problema de identificar em seus radares
quais avides eram aliados ou inimigos. Os aleméaes notaram que ao fazer manobras
com suas aeronaves ao retornar a base, o sinal de radio refletido sofria
modificacdes, e, com isso, 0 primeiro sistema RFID passivo foi criado. Sob a tutela
do fisico escocés Robert Alexander Watson-Watt, descobridor do radar, os ingleses
foram os pioneiros na tecnologia de identificador ativo de aliado ou rival, em inglés,
Identify Friend or Foe (IFF). Essa tecnologia funcionava com 0os mesmos conceitos
do sistema RFID passivo popularizado atualmente. Ainda no contexto da segunda
grande guerra: os avibes comecaram a ser dotados de transmissores, que, ao
receber o sinal da estac&o base, respondiam diretamente a elas. Assim, podiam ser
identificadas quais aeronaves eram amigas, e portanto, permitindo-se a sua

aproximacao.
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Figura 1. Linha do tempo da tecnologia RFID [1].

Seguindo o processo de evolugdo que culminou nas RFIDs, na década de
1960, foram desenvolvidos equipamentos eletronicos de vigilancia para prevenir
roubos. Na década de 1970, foi a explosdo da tecnologia (RFID Explosion). Nesse
periodo, os circuitos desenvolvidos permitiram tags menores e mais eficientes,
fazendo com que fossem utilizadas em experimentos para rastreio de animais e
automacdao nas industrias. Na década de 1980, pode-se ver um interesse maior no
setor de transporte como o pagamento automatico de pedagios e sistemas de
acesso pessoal. Na década seguinte, essa tecnologia despertou um grande
interessante no ramo de negdcios, para organizacdo de estogues, assim como a
substituicdo de cédigo de barras Optico. No inicio do século 21, as tags passivas
comecaram a ser introduzidas em documentos oficiais como passaportes, € no ramo
de varejo, elas comecaram a substituir cdédigos de barras. A linha do tempo do

desenvolvimento da tecnologia de RFID esta ilustrada na Figura 1.

1.1.1. Aplicagdes

O sistema RFID pode ser aplicado em diversos setores da sociedade, como
por exemplo o setor de varejo, hospitalar, industrial, identificagéo, eventos, etc.

No varejo, o RFID pode ser substituido pela etiqueta de codigo de barras,
agilizando o processo de identificagcdo e caracterizacdo do objeto, assim como a
contagem de estoque e procedimentos de seguranca contra furtos. Atualmente, ha
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uma adocdo enorme na industria para facilitar os processos de transporte, logistica,

qualidade, etc. E de nota citar o servico da Amazon GO, que utiliza RFID em larga
escala, no qual o cliente escolhe os produtos que deseja levar na loja fisica e
adiciona ao carrinho de compras. Os sensores eletromagnéticos fazem as leituras
desses produtos e a cobranca é feita automaticamente pelo smartphone no cliente.

Na industria, mais especificamente nos meios de transporte, pode-se observar
a agilidade provinda por esta tecnologia nos sistemas de cobrancas de pedagio e
estacionamento. Ao se implantar um adesivo no para-brisas do veiculo, gera-se uma
economia de tempo para o motorista, que nao terd mais a necessidade de parar
para efetuar o pagamento do pedagio ou do estacionamento.

Na medicina, é discutida a possibilidade da insercdo de chips subcutaneos
que permitirdo a identificacdo de toda a informacédo necesséria sobre um paciente.
Ainda na éarea de saude, € de nota observar que atualmente varios hospitais
empregam RFIDs para otimizar os processos administrativos, reduzindo possiveis
erros ao etiquetar remédios e equipamentos.

Atualmente, o uso mais popular do RFID é na identificacdo animal, que auxilia
no gerenciamento do controle de epidemias e na garantia de qualidade e
procedéncia. Esse processo pode ser feito através do uso de RFID na forma de
colares, brincos, etc. Outro uso que vem se tornando cada vez mais popular € nos
ingressos para eventos: RFIDs na forma de pulseiras permitem que a identificacédo

seja feita de forma réapida e eficiente, evitando assim filas e transtornos.

1.1.2. Empecilhos

7

O fornecimento de energia seja em tags ativas ou passivas, € um grande
empecilho nesta tecnologia. Para as tags ativas, a curta vida das baterias limita
avancos tecnolégicos neste dispositivo, uma vez que, quanto maior o poder de
processamento, mais energia sera gasta. Para as tags passivas, que serdo usadas
neste projeto, o rapido decaimento do sinal limita a distancia efetiva de identificacao,
obrigando que a tag esteja proxima do leitor. Dependendo da aplicacdo, essa
distancia pode ser um problema. Outro empecilho encontra-se nos erros de leitura
gue acontecem quando muitas tags RFID estdo posicionadas proximas umas das

outras. Neste cenario, ndo ha energia suficiente para que todas respondam a antena
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transmissora. Outro fator complicador é a orientacdo espacial das tags em relacéo

ao sistema transmissor.

1.2.Estado da Arte

A performance das antenas de RFID na faixa de UHF (que ser&o denotadas
como UHF RFID) é um dos pontos principais para garantir uma leitura eficiente no
seu sistema, e os tipos mais usados de antenas séo: as fixas, portateis e tags. Para
as fixas, pode-se ter as de polarizacdo circular, como a usada neste projeto, que
podem garantir uma largura de feixe de radiacdo largo (garantido mais tags lidas) ou
um feixe de radiacdo estreito (garantido uma maior diretividade e aumento da
distancia de leitura). Para as portateis, elas podem ser linearmente polarizadas [2],
duplamente polarizada [3] e circularmente polarizada [4]. Para as antenas do tipo
tags, existem poucos artigos que abrangem o design e sua a praticidade [5],[6] a fim
de otimizar a sua eficiéncia.

Os problemas encontrados no sistema de RFID — como o rapido decaimento
do sinal que limita a distancia efetiva e o erro de leitura das tags RFID quando
muitas estdo posicionadas préximas umas das outras pois ndo ha energia o
suficiente para que todas respondam a antena transmissora — podem ser mitigados
com o emprego de lentes formadas por metamateriais. Uma das mais conhecidas é
0 SRR (Split Ring Ressonator) [7-9] e o cross-shaped [10,11].

Outro problema comum do sistema de RFID é a que as tags ficam orientadas
aleatoriamente em relacdo ao sistema transmissor, impossibilitando assim que elas
sejam energizadas em certas circunstancias. Para resolver este tipo de problema,
solucbes como lentes insensiveis a polarizacdo foram projetadas [12], porém, ao
melhor do conhecimento do autor, ainda ndo aplicadas para o sistema RFID. E

nessa lacuna que o projeto em questéao visa trabalhar.

1.3.Objetivo

Identificados os problemas citados na Sec¢éo 1.1.2, o objetivo deste projeto é
desenvolver lentes baseadas em metamateriais para operarem entre as frequéncias
900 MHz e 928 MHz, que é a banda de operagédo da antena transmissora que sera

utilizada para a leitura das tags. Estas lentes serdo aplicadas para aumentar a
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precisao de leitura, distancia efetiva e tornar capaz a identificacdo das tags dentro de

embalagens ou invélucros.

1.4. Metodologia

Na primeira fase, foi feito uma pesquisa bibliografica sobre o tema RFID para o
conhecimento do estado da arte em identificacdo por radiofrequéncia e um estudo
sobre programas de simulacdo para eletromagnetismo computacional. O programa
empregado foi o High Frequency Structure Simulator (HFSS) e o CST
(Computer Simulation Technology).

Durante a etapa pesquisa da literatura técnica especializada, foram adotados
como referéncias principais os artigos [2] e [3], que propunham melhorias para a
resolucao de alguns problemas do sistema de RFID.

Na segunda fase, viu-se a necessidade de caracterizar a antena transmissora
empregada, buscando assim, através de medi¢Bes e calculos, seus parametros S,
ganho e diagrama de radiacdo. Isso foi necessario de devido a uma série de
imprecisfes encontradas da folha de especificacdes da antena em [30].

Na terceira fase, usando como referéncia o artigo em [2], onde é demonstrado
um tipo de lente de metamaterial cuja capacidade de focalizacédo é independente da
polarizacdo da onda eletromagnética incidente, projetou-se o metamaterial de
referéncia visando comprovar os resultados do artigo e posteriormente otimiza-lo
para que seja usado na frequéncia de operacéo desejada.

Na quarta fase, usando como referéncia o artigo em [3], onde € demonstrado
um tipo de lente de metamaterial conhecida como Cruz de Jerusalém e apresentava
algumas vantagens em relacdo a [2], projetou-se o metamaterial de referéncia
visando comprovar os resultados do artigo e posteriormente otimiza-lo para que seja
usado na frequéncia desejada.

Apoés desenhado, testado e otimizado, o sistema inteiro (antena + lente) foi
simulado no HFSS utilizando o método de elementos finitos, uma técnica numérica
no dominio da frequéncia (FD) usada para solucionar equacdes integrais lineares
reduzindo-as a uma equacao matricial.

Para confirmar os resultados da simulagcdo, prevé-se a fabricacdo de lentes

utilizando a tecnologia de circuito impresso (ex: cobre sobre o substrato de FR4),
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CUjoS recursos necessarios para realizacao estédo disponiveis no laboratorio.

1.5.0rganizacéo dos Capitulos

O restante deste trabalho esta organizado da seguinte forma. O Capitulo 2
apresenta uma revisdo do sistema RFID, da tecnologia de metamaterial e dos
fundamentos de eletromagnetismo usados neste projeto. O Capitulo 3 apresenta a
caracterizacdo da antena RFID. O Capitulo 4 compila resultados de otimizacao das
lentes de metamaterial usadas neste projeto. O Capitulo 5 resume o0s principais
resultados do conjunto antena + lente. No Capitulo 6 estdo sumarizadas as
principais conclusdes obtidas neste trabalho e as sugestfes para trabalhos futuros.
No Capitulo 7 esta a Bibliografia de referéncia. No Capitulo 8 estd o Apéndice A,

com um tutorial de como simular uma lente no HFSS.
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2. Fundamentos Teoéricos

2.1.Sistema RFID

2.1.1. Composicéao

Um sistema de RFID (ilustrado na Figura 2) € constituido por: antenas,
transponders, transceptor, dispositivos leitores e computadores com softwares
especializados em identificacdo. A antena € responsavel por emitir os sinais de
radiofrequéncia (RF) que identificam a etiqueta (tag). Os transponders séo etiquetas
gue podem ser passivas ou ativas. As passivas sdo compostas por um circuito
integrado (chip) RFID e uma antena responsavel por receber o sinal RF e energizar
o chip para que assim o codigo contido nele seja transmitido de volta. As etiquetas
ativas contém sua prépria bateria sendo capazes de se energizar e transmitir seu
sinal por contra prépria, fazendo com que possa ser lida a maiores distancias. O
transceptor faz a leitura do sinal e transmite o conteudo presente para o leitor. O
leitor € responséavel pela conversao das ondas de radio em sinais digital para que o
computador e o software de processamento de sinais possam compreender as
informagdes contidas na etiqueta. Neste trabalho serdo usadas etiquetas do tipo
Belt, mais especificamente TFT301 UHF LaundryChip, mais detalha na Secao 3.2.

Leitora envia eqer ia
para acion ar TRANSPONDERS /
e W W TAGS
—
dados
datahora “ & |
= energia
TR Lo
S TAG envia ID
e Data para a Leitara

Figura 2. Componentes de um sistema RFID [13].

2.2.Teoria dos Metamateriais

O termo metamaterial (MTM), tem origem na palavra grega meta, que significa
“além” [14]. Ele descreve materiais fabricados artificialmente, que possuem

propriedades eletromagnéticas que podem ser controladas para ir além das
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encontradas na natureza. Outros nomes utilizados para se referir aos MTMs séo

Materiais de indice Negativo (em inglés Negative Index Materials - NIM), Meio
Duplamente Negativo (Double Negative Media - DNG), Materiais Left Handed (LH)
ou ainda Meio de Onda Inversa (Backward Wave Media - BW).

O metamaterial representa uma classe de materiais que sao
microscopicamente heterogéneos, construidos a partir de arranjos metalicos com
formacdes periddicas cujas dimensdes sdo menores que o comprimento de onda do
espaco livre ou da onda guiada [15]. Justamente por causa do periodo muito
pequeno, pode-se tratar essas estruturas como materiais homogéneos,
caracterizadas pelos parametros constitutivos de € (permissividade elétrica) e
(permeabilidade magnética). Na fabricacdo de um metamaterial, tem-se diferentes
graus de liberdade, como as propriedades dos materiais, tamanho, forma e
composicdo das inclusGes nas células unitarias, densidade, disposicdo e
alinhamento das mesmas, entre outros. Esses parametros sao utilizados para para o
projeto de um meio de propagacdo com caracteristicas eletromagnética que se
deseja [16].

Os metamateriais sdo compostos de elementos do mesmo modo que a
matéria consiste de atomos (Figura 3). Os elementos estruturais, ou inclusdes, sao
pequenos blocos, também chamados de células unitarias, equivalentes a “moléculas
artificiais”. As possibilidades de combinar varias formas de inclusdo, como por
exemplo hélices, fios dobrados e até varios pequenos componentes eletrénicos séo

virtualmente infinitas [17].

-

T

ATOMOS MEIO
ARTIFICIAIS EFETIVO

Figura 3. Comparacéo entre material convencional e Metamaterial [18].

ATOMOS MEIO
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2.2.1. Classificacdo dos Metamateriais

Podemos classificar os materiais em quatro grupos, de acordo com 0S seus
parametros constitutivos € (permissividade) e y (permeabilidade):

[] € negativo e y positivo: material epsilon negativo (Epsilon Negative Media -
ENG), encontrados na natureza, sao os plasmas.

[] € e p positivos: material duplamente positivo (Double Positive Media - DPS),
facilmente encontrados na natureza, sao dielétricos como agua, vidro,
plastico, etc.

[ € e p negativos: material duplamente negativo (Double Negative Media -
DNG).

[] € positivo e y negativo: material um negativo (Mu Negative Media - MNG),
também presentes na natureza como materiais magnéticos.

As qualificacBes descritas acima estdo mostradas esquematicamente na Figura 4.

Isotropic Dielectrics

Plasmas | Right-handed

Metals at optical frequencies Positive wave propagation
Evanescent (decaying) waves Phase delay

e<0, >0 m
e>0, u>0
> &
DNG Material MNG Material
Not found in nature Ferrites

Left-handed
Backward-wave propagation
Phase advance

W e>0, u<0

e<0, u<0

Magnetic materials
Evanescent (decaying) waves

Figura 4. Esquemético da caracterizacdo dos materiais de acordo com os valores de permissividade e
permeabilidade [15].

A hipdtese de um material com indice de refracdo negativo foi levantada em
1967-1968 por Veselago, que mostrou que um indice de refracdo negativo seria uma
propriedade essencial do material teérico cuja permissividade e permeabilidade
fossem menores que zero [14, 15, 16, 19]. Posteriormente, J. B. Pendry apresentou
0 objetivo ambicioso de criar lentes perfeitas, ao qual seria necessario projetar um
meio artificial que possuisse propriedades especificas, ndo observadas em materiais
naturais, ou seja, um meio com [l e y negativos [20]. Somente em 2000 um

metamaterial baseado em fios condutores e ressonadores Split-Ring (SRRS),

21



\\ Projeto de Graduagao

DEPARTAMENTO
DE ENGENHARIA
ELETRICA

demonstrou ter um indice de refracdo negativo em uma regido de frequéncias de

micro-ondas [16, 19].

2.2.1.1. Materiais Duplamente Negativos (DNG)

Os materiais DNG sao realizaveis artificialmente com o intuito de projetar,
aprimorar ou aumentar o desempenho de lentes, circuitos de micro-ondas, linhas de
transmissao, antenas, divisores de banda, entre outras aplicacoes. Para a aplicagcéo
em antenas, que € o foco desse trabalho, foi visto que a utilizacdo desse tipo de
material juntamente com elementos radiantes, pode aumentar a poténcia irradiada e
0 ganho para uma dada frequéncia da operacéo [15].

Os primeiros materiais DNG construidos utilizavam, como j& foi comentado
anteriormente, uma estrutura composta por ressonadores Split-Ring e um fio,
conforme mostrado na Figura 5. Foi sugerido que o SRR iria contribuir com uma
permeabilidade negativa, enquanto o fio de comprimento infinito contribuiria com
uma permissividade negativa e a combinagdo de ambos em uma estrutura periddica
(Figura 6), levaria a um indice de refracao negativo [14, 15].

Uma série de experimentos foram realizados a fim de encontrar e verificar
novas estruturas para materiais DNG. Uma célula de metamaterial em forma de S
forneceu uma geometria alternativa que simulava permissividade e permeabilidade

negativas sem necessitar do fio infinito para a permissividade negativa.

4/

/ (b)

Figura 5. Geometria de uma célula unitaria de material DNG usando um SRR e um fio. (a) SRR. (b)
Fio [15].
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Figura 6. Metamaterial formado por estrutura periddica de material DNG [15].
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2.2.1.2. Refracdo e Propagacdo através de materiais DNG

As definicdes das propriedades eletromagnéticas em um meio DNG foram
estudadas e analisadas por diversos grupos exaustivamente. Eles mostraram
matematicamente que nos meios DNG, o indice de refracdo pode ser negativo. Em

um meio onde € <0 e y <0 com pequenas perdas, pode-se definir [16]:

&g — j&' = —j (Isrsol /24— ) 1)
2|ergo|

— _ / Il )

Hrio — JH J(Iuruol 2, (2)
Como numero de onda k e a velocidade da luz ¢ sdo dados por
k= wVeyp 3
1

= 4
¢ v €oko ( )

pode-se chegar a expressao do indice de refracdo para materiais DNG

1
_ ke _ T e luel ' le\] 2
/ / IsIIuI———>+'< -
€ .|Ho e € Mo ) €o Ho

12

el 2l 2 [1 472 (E+ L] (5)

lerleo [1rlpo

Fica evidente que pode-se obserterpartes real e imaginaria negativas.
Considerando uma interface separando dois meios cujos indices de refracdo
de ambos materiais sdo positivos, de acordo com a Lei de Snell, isto €,

n, sin6; = n, sin 6, (6)
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a onda transmitida estard& do mesmo lado da onda refletida, conforme

ilustrado na Figura 7(a). Para o caso de um dos materiais ser DNG e ter indice de
refracdo negativo, pela lei de Snell, o angulo refratado também devera se tornar
"negativo" e a onda transmitida ficard na diregcdo oposta da onda refletida, como
visto Figura 7 (b).

DPS DPS DPS DNG

Transmitted

Reflected Reflected

6, )y 9

6

Incident €2, Ha, My ‘ —&9, =y, —N
Incident

£, K-
£ s My

Transmitted

(a) (D)
Figura 7. Reflex&@o e transmissdo de uma onda em uma interface (a) DPS-DPS e (b) DPS-DNG [15].

Para materiais com indice de refracdo negativo, a constante de fase (niumero
de onda) que viaja no material DNG € negativa, o que quer dizer as frentes de onda
de fase se moverdo em direcdo a fonte. Ou seja, a fase ira avancar, ao invés de
sofrer o atraso tipico dos materiais convencionais. Um exemplo desse fendmeno é

mostrado na Figura 8.

Figura 8. Exemplo de refracdo em interface de material DNG [16].

Uma consequéncia de € e p serem negativos € que, quando alteramos o sinal
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de € e py nas quatro equacdes de Maxwell, temos que o vetor de fase k e a

velocidade do grupo ou o vetor de Poynting estdo na direcdo oposta para 0s
metamateriais. Desse modo, a fase da onda parece ondular para trds enquanto a
energia se propaga para a frente. A direcdo da velocidade da fase & especificada
pelo vetor de fase k, enquanto a direcdo de propagacao da energia ou a velocidade

do grupo séo indicadas pelo vetor Poynting [14], como visto na Figura 9.

H

Plane wave in a usual isotropic medium Plane wave in a backward-wave medium

Figura 9. Onda plana em meio com indice de refracdo positivo (esquerda) e negativo (direita) [17].

2.2.1.3. Aplicagcdes dos Metamateriais

Com os parametros incomuns dos MTMs, novos tipos de antenas,
componentes e dispositivos de micro-ondas podem ser criados para as
comunicacdes sem fio. As principais aplicacdes possiveis para esse tipo de material
sdo na area da Optica. Todas as lentes produzidas por materiais convencionais sdo
limitadas pelo comprimento de onda da luz, ja que elas ndo conseguem focalizar em
uma area menor que o comprimento de onda ao quadrado devido ao limite de
difracdo. Com os metamateriais, uma “super” lente que possa focalizar recursos
menores que o comprimento de onda da luz passa a ser possivel [14].

Outra aplicacdo possivel € na area de comunicacbes, em que € possivel
construir antenas leky-wave com capacidade de varredura para tras e para frente
usando esses metamateriais. Combinando as antenas convencionais e que utilizam
materiais DNG, é possivel construir uma antena com a capacidade de cobrir em
todas as dire¢cbes do espaco.

Outras aplicacdes que podem ser citadas sdo antenas super compactas,
acopladores direcionais, filtros, divisores e combinadores de poténcia, filtros

harménicos para amplificadores de alta eficiéncia e componentes de dupla
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frequéncia [21].

Além desses exemplos, muitos pesquisadores estdo tentando melhorar o
desempenho de micro-ondas, comunicagdes sem fio, microeletronica e dispositivos

Opticos usando esses novos metamateriais.

2.3.Metamateriais em RFID

O foco desse trabalho € a utilizagdo do metamaterial em RFID. Uma lente de
MTM € capaz de aumentar o ganho de uma antena, melhorando assim a
comunicacdo do sistema. Diversos trabalhos que utilizam um material DNG para
comunicacgdo RFID foram feitos nos ultimos anos [8, 10, 11, 15, 22, 23 ,24].

As antenas RFID definem o custo e o tamanho das tags [10], por isso é
importante que elas sejam eficientes. A caracteristica principal que determina o
desempenho de uma tag RFID é o seu alcance de leitura. Normalmente, para se
aumentar o ganho de uma antena, e consequentemente seu alcance, utiliza-se uma
placa de metal como um plano de terra que atua como refletor. Para frequéncias de
UHF, essa placa deve estar a uma distancia minima de um quarto de onda (cerca de
10 cm), o que faria com que as tags tivessem muitas vezes, tamanhos além do
aceitavel [22]. Por esse motivo, comecou-se a estudar a possibilidade de utilizar
lentes de metamaterial como uma forma de aumentar o ganho e a diretividade das
antenas.

Em [15], utilizou-se uma estrutura SRR para construir um MTM que levasse
ao aumento do ganho da antena. Em [10], montou-se um material DNG com células
na forma de cruz. Foi verificado também que em comparacdo com o plano de terra,
o ganho da antena com metamaterial foi 1.8 dB maior, mostrando que sua utilizacdo

para essa aplicacéo é valida e vantajosa.

2.4.Fundamentos do Eletromagnetismo e Eletromagnetismo Aplicado

2.4.1. Equacao da Onda

O termo onda se refere a solucdo da equacdo de onda. Os campos
eletromagnéticos obedecem as equacdes de onda e, portanto, as expressdes campo

e onda sao sinbnimos em eletromagnetismo [25]. Vamos considerar nesse trabalho,
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campos em meios fora da regido das fontes, lineares, homogéneos e isotropicos. As
equacdes rotacionais de Maxwell na forma fasorial séo dadas por [26]
VXE= —jouH (7)
VXH= jweE (8)
Em que o fator harmonico no tempo exp(jwt) foi assumido e omitido.
Tomando o rotacional da primeira equacao, temos:
VXVXE= —jopVXH= w?ucE 9)
Utilizando a identidade vetorial VxV x A = V(V.A) — V2A, conseguimos
escrever a expressao acima na forma de uma equacao de Helmholtz vetorial para o
campo elétrico desacoplada do campo magnético, isto €
V’E + w?pcE =0 (10)
De modo dual, podemos encontrar a equagdo da onda para 0 campo
magnético:
V’H + w?ueH =0 (11)
Definimos a constante k = w+/pue como o nimero de onda ou constante de
propagacdo no meio. Essas equacdes também sdo conhecidas como equacdes
vetoriais de Helmholtz. Podemos resolvé-las fazendo sua decomposi¢cdo de acordo
com o sistema de coordenadas definido. Para esse trabalho, utilizaremos o sistema
retangular. Considerando que o campo elétrico s6 tenha componente dire¢cdo x e

gue ele ndo depende de x e y, a equacdo de Helmholtz passa a ser:

i T+ KB, =0 (12)

Cuja solucao é na forma:
Ey(z) = Eote X2 + E, etik? (13)
onde E,* e E,” sdo constantes arbitrarias de amplitude. O campo magnético

associado € encontrado a partir da equacao de Maxwell:

jouH = —V X E = ay jkE, (14)
Que pode ser escrito na forma:
Ex
Hy = 7 (15)

Em que n é a impedancia da onda, dada porn = C')“/k = f”/g.
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2.4.2. Propagacédo em Dielétricos

Vamos considerar agora uma onda plana se propagando em um meio
dielétrico. Os dielétricos reais sdo meios que apresentam perdas elétricas, ou seja, a
condutividade elétrica é tal que o # 0. A diferenga para esse caso, € que a
constante de propagacao deixa de ser puramente real e passa a ser complexa. As
equacdes de Maxwell nesse caso passam a ser [26]:

VxE= —jouH (16)
VX H = jweE + oE (17)

A equacéao de onda fica na forma:
VE + w?pe (1- jZ)E =0 (18)
E a constante de propagacao fica definida como:
v = a+jB=jovie |1- (19)
Em que a« € a constante de atenuacdo e S € a constante de fase.

Considerando novamente o problema do campo elétrico com componente apenas

em X e independente de variacdes em x e y, a equacao de onda fica:

9%Ey
5z Y 2E, =0 (20)
Cuja solucao é:

Ex(z) = Eote™? + E, etV? (21)

Onde, efY%z = etaz 4Pz,

2.4.3. Teorema de Poynting

Os campos eletromagnéticos sdo utilizados para transportar informacoées, e
para isso, eles armazenam energia e carregam poténcia. A partir da equacao de
conservacao de energia podemos chegar no teorema de Poynting, que é uma
equacao de balanceamento de poténcia. Esse desenvolvimento matematico pode
ser encontrado em [26, 27].

Considerando uma regido como a expressa na Figura 10, em gque se tem um
volume V, fechado por uma superficie S, na presenca dos campos E e H e das

fontes de corrente Jg e Mg, 0 teorema de Poynting é expresso por [26]:
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Figura 10. Campos elétrico e magnético, gerados pelas fontes de corrente Js e Ms [27].

1 1
——f (E.J: + H*.Ms)dv=—j£ E x H*dS
2V 2 S

+ > [y B dv+ = [ (" [E]* + @’ [HI*) dv+j= [, (W [H|* — € [E|*)dv
(22)
Em que, o sobrescrito * significa 0 complexo conjugado, a permissividade e a
permeabilidade complexas para o caso com perdas sdo dadas por €= ¢ —je" e
u= pu —ju". A poténcia complexa P;entregue pelas fontes J; e Mg dentro de S é:
1 * *
Po= ——f, (E.Ji + H" .My) dv (23)
O fluxo de poténcia complexa P, fora da superficie fechada S é:
1 " 1
PO:E¢SEXHdS:E§S Sds (24)
Onde S = E x H* é o vetor de Poynting. A poténcia dissipada P, no volume V
devido as perdas dielétricas, magnéticas e de condutividade sdo expressas como:
Pp= [, [EZdv+ 2 [ (" [E[* + " [H|?) dv (25)
Essa relacdo também é conhecida como a lei de Joule. As energias elétrica
(W,) e magnética (W,,) armazenadas podem ser representadas como:

W, = va E.E*dv (26)

Wp = =f, H.H"dv (27)
O teorema de Poynting quer dizer que a poténcia entregue pelas fontes é
igual a soma da poténcia transmitida pela superficie, da poténcia dissipada e de 2w

vezes a poténcia reativa armazenada. Por fim, ele pode ser reescrito da forma:
P,= P, + P+ 2jw(W, — W) (28)
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2.4.4. Polarizacéo

A polarizacdo de uma antena € definida pela polarizacdo da onda irradiada
por ela e, a polarizagdo da onda é definida como “a propriedade de uma onda
eletromagnética que descreve a direcdo e a amplitudes, variantes no tempo e a
magnitude relativa do vetor do campo elétrico; especificamente, a figura tracada em
funcd@o do tempo, do vetor campo elétrico; especificamente, é a curva tragada, em
funcdo do tempo, pela extremidade do vetor em um ponto fixo do espaco e o sentido
em que é tracada, sendo observada ao longo da direcdo de propagacdo” [28]. Em
outras palavras, polarizacdo é a curva tracada pela extremidade do vetor campo
elétrico instantaneo, num plano fixo ortogonal a direcdo de propagacdo, como pode

ser visto na representagdo da Figura 11 a seguir.

Figura 11. Curva tipica de polarizagdo da onda em fungé&o do tempo [28].

Podemos classificar a polarizacdo como linear, circular ou eliptica,
dependendo da curva tracada. Dizemos que a polarizacao é linear, se observarmos
o vetor que descreve o campo elétrico se direciona ao longo de uma linha reta
normal a direcdo da propagacéo. Se a curva apresentar o formato de uma elipse, o
campo é polarizado elipticamente. Se tiver o formato de um circulo, é polarizado
circularmente. As polarizagfes lineares e circulares séo casos especiais da eliptica.

Podemos ainda classificar as polarizagbes como a direita ou a esquerda, de
acordo com o sentido tracado pelo campo. Se estiver em sentido horério, diz-se que
ele esta polarizado a direita, no sentido anti-horario, esta polarizado a esquerda. Na
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Figura 12, sdo apresentados exemplos de polarizacbes lineares, circulares e

elipticas.

K

(a) (b)

Figura 12. Exemplos de curvas de polarizagdo em um plano fixo da direcdo z. (a) Linear, (b) circular e
(c) eliptica [28].

2.4.5. Polarizacéo Linear, Circular e Eliptica

Os campos complexos E e H, variantes no tempo pela forma e/®t, se
relacionam com os campos instantaneos £ e H por [28]:

E(x,y,7t) = Re[E(x,y,2)e/*] (29)

H(xy,7z;t) = Re[H(x,y,2)e/*!] (30)

Portanto, uma onda plana que viaja no sentido positivo de z, representada

pela equacao (31), pode ter suas componentes complexas descritas como:

EY) = 4 E(z 1) + 4, &, (z 1) (31)
Ex(z;t) = Re[Eye@K2)] = E g cos(wt — kz + ¢y) (32)
Ey(z;t) = Re[Ey@ @] = Eyq cos(wt —kz + ¢,) (33)

em que Ey, e Ey, séo as amplitudes maximas das respectivas componentes.

Uma onda com polarizacdo linear requer que a diferenca de fase entre as
componentes seja ser um multiplo de 1, como visto abaixo.
Ab = ¢y — ¢y =nm, n=20,123,.. (34)
A polarizagao circular requer que as amplitudes das duas componentes sejam
iguais e a diferenca de fase seja um multiplo impar de T11/2. Isso pode ser descrito
matematicamente da seguinte forma:
|Ex| = |£y| — Exo = Eyo (3%5)
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(5 + Zn) T polarizagdo circular a direita
Ap = by — Ok = 1 (36)
— ( + Zn) s

polarizagao circular a esquerda

paran=0,1,2,...

Para o caso da polarizacdo eliptica, temos duas condicbes possiveis, a
diferenca de fase deve ser mdltiplo impar de m/2 e as amplitudes devem ser
diferentes, ou a diferenca de fase deve ser diferente de um multiplo impar de /2,

independente das amplitudes. Isso pode ser descrito matematicamente da seguinte

forma:
€] # |€y] = Exo # Eyo (37)
G + Zn) m  polarizagao circular a direita
Ap = by — Py = 1 L . (38)
— (5 + Zn) m polarizagao circular a esquerda
paran=0,1,2, ...

2.4.6. Fator de Perda de Polarizacao

Dificilmente a polarizac@o da antena receptora sera igual a da onda, levando a

uma perda de polarizacdo. Vamos considerar que o campo elétrico incidente e a

polarizacdo da antena receptora sdo expressos pelas equacdes (39) e (40),
respectivamente.

Ei = pwEi (39)

E, = Paka (40)

em que p,, € 0 vetor unitario da onda e p, € o vetor de polarizacdo da antena. O

conceito de Fator de Perda de Polarizacdo (Polarization Loss Factor — PLF) é

utilizado para mensurar a perda de polarizacdo. Ele é definido como:
—~ —~ 2
PLF = |pw-pa|2 = |C05¢p| (41)
em que y,€ o angulo entre os vetores. Se a antena estiver perfeitamente casada

com a polarizagdo da onda, ndo haveréo perdas e o valor de PLF serd 1. A Figura
13 ilustra alguns cenarios nos quais a perdas de polarizagcdo pode ser nula, ou

mesmo total.
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Figura 13. Trés casos de casamento de polarizacao e seus respectivos Fatores de Perda de
Polarizacédo [28].

2.4.7. Reflexdo e Transmissao de Ondas com Incidéncia Normal

Uma onda, ao incidir sobre um obstaculo, terd parte da sua energia
transmitida e parte refletida. O quanto de energia ird para cada parte, depende dos
parametros constitutivos dos meios. A incidéncia normal ocorre quando a direcéo de
propagacdo da onda é perpendicular ao plano de incidéncia, como visto na Figura
14.

”

Figura 14. Transmisséao e reflexdo de uma onda plana com incidéncia normal [27].

Considerando um campo elétrico, polarizado em x e de amplitude E,, como
expresso em (32) que se encontra no meio 1 (com parametros u,; e &), incidindo
sobre o0 meio 2 (com parametros u, e &,), podemos escrever 0s campos incidente,
refletido e transmitido por [27]:

El = a, Ejeikiz (42)
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E' = 4, [PEyetik? (43)
Et = 3, TPE e Tke? (44)
m quel® é o coeficiente de reflexdo e TP o coeficiente de transmiss&o da interface.

De modo similar, encontramos as expressfées para 0 campo magnético.

; E
Hi= 3. =2 —]klz 4
dy o, (45)

r — _a rbEo +jkz
H ay I ol (46)

Os coeficientes TP e TP sdo determinados pelas condi¢cées de contorno do
problema, que determinam a continuidade dos campos tangenciais a interface (em z

= 0). Assim, fazendo os desenvolvimentos descritos em [27, 29] chegamos as

expressoes:
14+ T1P=TP (47)
b= Ne—m_ B H (48)
N2+1M1 El Hi
To= 2o B mi (49)

nz+ny  El ngH
Portanto, sabendo os parametros constitutivos do meio, conseguimos
encontrar os coeficientes de reflexdo e transmissdo, e tendo conhecimento de um

dos campos, podemos encontrar os demais.

2.4.8. Ondas Estacionarias

Uma onda estacionaria se forma quando duas ondas iguais, que viajam em
direcBes opostas se sobrepdem. O padréo formado por elas pode ser visto na Figura
15. Em [27], temos o desenvolvimento matematico das caracteristicas das ondas
estacionarias. As informacdes relevantes para esse trabalho, sdo comentadas a

sequir.
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Figura 15. Padrao de onda estacionaria em funcao da distancia, para diferentes coeficientes de
reflexéo [27].

As distancias entre maximos e minimos adjacentes, é sempre de meio
comprimento de onda, e esses valores de maximo e minimo estdo relacionados com
o coeficiente de reflexdo do meio, através das expressoées [29]:

Emax =1+ T (50)
Emin =1—1T] (51)

A razao entre esses valores é conhecida como SWR (Standing Wave Ratio).
O SWR é uma quantidade capaz de ser medida por instrumentos, seu valor fica
entre 1 < SWR < . Ele indica a quantidade de interferéncia entre uma onda
propagante e outra na direcdo oposta. Se o valor do SWR for 1, quer dizer que [T| =
0, ou seja, nao ha interferéncia. Caso [I'| = 1, as duas ondas tém mesma amplitudes
e direcdes opostas, levando a um SWR infinito, ou seja, € uma onda estacionaria.

|Emaxl 1-|T|

(52)

2.4.9. Parametros de Espalhamento

Os valores medidos por equipamento nos passam uma ideia sobre as ondas
incidentes, refletidas e transmitidas. Uma representacao utilizada para esses dados
sdo as matrizes de espalhamento. Elas descrevem a relacdo entre as tensodes
incidentes e refletidas em uma rede de portas [26]. A Figura 16 apresenta uma rede

de duas portas com a formulagéo da matriz de espalhamento.
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Figura 16. Representacéo dos elementos da matriz de espalhamento para uma rede de duas portas.

Considerando a amplitude da tenséo incidente em uma porta n como V;} e a
refletida por essa mesma porta como V;, podemos relacionar esses valores de

tensdo pela matriz de espalhamento S, como visto abaixo [26, 29]:

Vl 511 1 V1+

n| |+
V2 [ s % (53)
- N o

A expressao também pode ser escrita na forma:

[VI™ = [S][V]* (54)

Os elementos S;; indicam o0 quanto de tensdo que entra pela porta i sai pela
porta i, ja os elementos S;; 0 quanto de tenséo que entra pela porta j e sai pela .

Ao se casar todas as portas, exceto uma, conseguimos encontrar 0
coeficiente de reflexdo associado aquele elemento (equacdo 55). Os demais
elementos da matriz S podem ser encontrados ao se analisar o circuito da rede.

Sij = X_ﬂ_r . _ (55)
tlvf=o0, k#j

Dizemos que uma rede € reciproca quando S; = S;;. Essa caracteristica €

comum de redes passivas, em que ndo se tem elementos ativos.

2.4.10. Perda de Retorno

A perda de retorno normalmente descreve redes de duas portas. Em um
sistema casado, essa perda € infinita, pois o coeficiente de reflexdo sera nulo, ja que
todo o sinal ser& transmitido. A perda numa porta i € dada pela seguinte expressao
[29]:

RL; = —201log = —20log|T;] (56)

_1
+
l
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2.4.11. Medidas com Modelos em Escala

Para alguns tipos de aplicacdes, as medi¢cbes de teste de antenas nao sao
facilmente realizaveis. Para contornar esse problema, pode-se utilizar a técnica de
modelagem por escala geométrica, ou escalonamento, que permite simulacdes e
testes com réplicas da antena desejada em outras escalas fisicas.

A Tabela 1 é uma versao reduzida da apresentada em [29], onde temos as

regras para o escalonamento por um fator n. Os parametros com 0 primo Sao 0s em

escala.
Tabela 1. Relac¢des de escalonamento [27]

Parametros Escalonados Parametros Inalterados
Comprimento =1/, Permissividade g =c¢
Comprimento de A = A/n Permeabilidade W =npu
onda
Capacitancia Cc' = C/n Velocidade vi=v
Indutancia U= L/ Impedancia 7' =17
Frequéncia f' = nf Ganho da antena Go' = Gy
Condutividade o' =no

2.4.12. Teoria de Antenas

Uma antena € um dispositivo capaz de radiar e receber ondas de radio. Em
sistemas sem fio, ela € o elemento principal, devendo ser bem projetada para
apresentar alto desempenho.

Diversos parametros sao utilizados para tornar possivel quantificar o

desempenho de uma antena. Alguns deles seréo citados a seguir.

2.4.12.1. Diagrama de Radiac¢ao

E a representacdo grafica das propriedades de radiagcdo a antena, como
densidade de fluxo de poténcia, intensidade de radiacdo, intensidade de campo,

diretividade, fase ou polarizacdo, em funcao de coordenadas direcionais [28]. Esses
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diagramas normalmente sdo normalizados e apresentados em escala logaritmica.

Um exemplo de diagrama de poténcia € mostrado na Figura 17.

Major lobe

First null beamwidth
(FNBW) \

Half-power be: mmullh
(HPBW)

Minor lobes ~

~ Back lobe
Minor lobes
X

Figura 17. Diagrama de radiagé&o [28].

O diagrama de antenas direcionais € formado por lobulos, que podem ser
classificados como principal, secundario, lateral e posterior. O I6bulo principal &
aquele na direcdo de maxima radiacdo, ou seja, aquele de maior intensidade. O
secundario é definido como qualquer outro que ndo seja o principal, j& o l6bulo
lateral é qualquer I6bulo que néo esteja na direcdo do I6bulo desejado. E finalmente,
0 posterior é aquele que se encontra a um angulo de 180° do feixe da antena. No
planejamento de antenas, busca-se minimizar os Iébulos laterais, jA que eles sao

indesejados.

2.4.12.2. Largura de Feixe

E a separac&o angular entre dois pontos opostos do maximo de um I6bulo do
diagrama. Existem diversas larguras, a mais comumente usada € a Largura de Feixe
de Meia Poténcia (LFMP, ou em inglés Half-Power Beamwidth — HPBW). Ela é
definida como o angulo entre as duas dire¢cbes em que a intensidade é a metade do
valor maximo [28]. A largura de feixe descreve a resolucdo da antena, ou seja, ela

indica a capacidade da antena de diferenciar entre duas fontes.
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Para determinar os pontos que definem a largura de meia poténcia, deve-se

encontrar o ponto equivalente a -3 dB em relacgdo ao maximo do diagrama de

poténcia, como mostrado na Figura 18.

Figura 18. Diagrama de Radiacéo de poténcia em dB e o feixe de meia poténcia (HPBW) [28].

2.4.12.3. Diretividade

Diretividade é a razdo entre a intensidade de radiagcdo da antena e a
intensidade de radiacdo de uma fonte isotrépica. Ela descreve o quanto a antena
consegue direcionar a energia para uma direcdo especifica do espaco. A sua

expressao é mostrada a seguir [28]:
4myU

D= (57)

Prad

onde D é a diretividade, U é a intensidade de radiacdo e P.,q € a poténcia radiada
total. Para uma antena isotropica, D serd igual a um, ja que ela ira irradiar igual para
todas as direcdes, para outros tipos de antena, ele sera maior que um.

Para casos em que as fontes possuem diagramas de irradiacdo de dependam

de duas coordenadas esféricas, temos as seguintes expressdes para U e P.,4:

~ o[ Es(8, )17 + [Eq(6, &[] (58)

Praa = 5, UG, 0) d2 = [I™ [TU(8, ) send dodep (59)
em que Eq e E, sdo as componentes do campo elétrico na regido de campo distante.

A expressao da diretividade e da diretividade maxima requerem céalculos complexos.
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Como alternativa ao célculo das integrais acima, existem aproximacfes que podem

ser feitas para facilitar o calculo da diretividade. Uma primeira aproximacédo € a
formula de Kraus, dada na equacgdo (60). Ela pode ser utilizada quando o I6bulo

principal é estreito e os secundarios podem ser desprezados.

41T

Dy =
©1r 02y

(60)

em que D, € a diretividade maxima, ©,,. a largura de feixe de meia poténcia em um
plano e ©,,,a em um plano perpendicular, ambas dadas em radianos.

Outra aproximacédo para a diretividade bastante popular é a formula de Tai &
Pereira, cuja derivacédo é feita em [28]. Ela apresenta outra formula para o célculo da
diretividade maxima, dada a seguir:

22,181
2 2
017+ 02

Dy = (61)

A férmula de Kraus € mais adequada para diagramas mais largos e a de Tai &

Pereira para diagramas mais estreitos.

2.4.12.4. Ganho

O ganho de uma antena é um parametro que leva em consideracao tanto a
diretividade quanto a eficiéncia da mesma. Ele é definido como a raz&o entre a
intensidade de radiacdo da antena em comparacdo com a intensidade de radiacao
de uma antena isotrépica. Algumas manipulacdes matematicas foram feitas em [28]
para se chegar a expressao de ganho dada abaixo:

G(8,¢) = eD(6,¢) (62)
em que e é a eficiéncia de radiacdo da antena. Normalmente, quando nos referimos
ao ganho da antena, estamos nos referindo ao ganho maximo, relacionado a
diretividade maxima. A equacdo do ganho maximo pode ser observada na equacao
que se segue [28].

Go(8, ) = eDy (63)
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2.4.12.5. Regides de Campo

Uma antena € envolta por trés regides, sdo elas: a de campo proximo
radiante, a de campo proximo radiante (ou regido de Fresnel) e a de campo distante
(ou regido de Fraunhofer). As definicdes das trés regibes segundo [28] sao vistas
abaixo:

[] Campo proximo reativo: regido imediatamente ao redor da antena, onde
predomina o campo reativo, sua fronteira é definida por R = 0,62,/ D3/, onde
D € a maior dimensédo da antena e 1 é o comprimento de onda;

[1 Campo préximo radiante: regido intermediaria, em que predomina o campo
radiante e a distribuicdo angular dos campos depende da distancia a antena,
sua fronteira é definida por 0,62\/D3_//1 >R < 2D%/2e

[J Campo distante: regido em que a distribuicdo angular dos campos nao

depende da distancia da antenae R > 2D?/A.
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Near-field o

/ \ Radiating \ Far-Field
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Figura 19. VariacGes no diagrama de amplitude de uma antena para as diferentes regides [28].

A Figura 19 apresenta a variagdo do diagrama de amplitude de uma antena a
medida que passamos de uma regido para a outra. E possivel observar que na
regido de campo distante, o l6bulo principal é mais bem definido que nas demais

regides.
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2.4.12.6. Equacao de Friis

A equacao de Friis da a relacao entre as poténcias transmitida e recebida por
duas antenas, a uma distancia R que esteja na regido de campo distante. A

densidade de poténcia da antena transmissora é dada pela relacdo a seguir [28]:

_ PGe(Bpdy) P¢D(0¢,¢¢)
Wt - 41R2 = % 4mR2 (64)

A poténcia recebida pela antena é definida como:

P = W, 4, (65)
A area efetiva da antena receptora A, pode ser representada pela expressao:
4 = e (8,4 (2) (66)
Portanto, a equacao pode ser escrita da forma:
Po= e D(0r b)) W = g0, TR 00D 5 |2 (67)

A equacdao de Friis relacionando as duas poténcias para o caso de eficiéncias

unitarias e alinhadas na dire¢cdo de maxima radiacao é:

% (2 GorGor (68)

Pt 4TR
No caso mais geral, em que as antenas nao s&o casadas com suas
respectivas linhas de transmisséo e também néo ha casamento de polarizacao entre

as antenas, a expressao fica na forma:
Py 1)? A
o= el (1= IR A= L) () DO do) DOy, &) [Be 17 (69)

2
O termo (ﬁ) € chamado de fator de perda do espaco livre, ele leva em

conta as perdas da antena causadas pelo espalhamento do sinal, ndo tendo relacao

com nenhum parametro da antena.
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3. Antenas Estudadas

3.1. Antena RFID

A antena (Figuras 20 e 21) usada como transmissora neste projeto foi
fabricada pela LairdTech, do modelo S9028PCLF, de polarizagcéo circular esquerda
ou direita e gera recepc¢ao e transmissao de sinais na banda de frequéncia 902 MHz

- 928 MHz, maiores especificagdes na Figura 22.

i

Figura 21. Antena modelo S9028PCLF sem radome.
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Antenna Part Number S9028PCLF / $9028PCRF
Frequency Range 902 - 928 MHz

Gain 9 dBic

Maxium VSWR 1.3:1

3 dB Beamwidth - Azimuth 70"

Front to Back Ratio 20dB

Polarization Circular Right or Left
Maxium Input Power 10 Watts

Input Impedence 50 Ohms

Axial Ratio 1dB Typical

Weight (Kg) 2.3 Ibs (1.04)
Mechanical Size 10.2" x 10.2" x 1.32"
Antenna Connection Coax Pigtail, Rev TNC Male [others available)
Radome High Strength PC

Mount Style Flush mount to wall
Temperature Operational -25°C to +70°C

Lightning Protection DC Grounded
Environmental Rating IP 54

Figura 22. Parametros importantes da antena S9028PCLF [30].

O desenho da antena feito no CST, usado para fazer a simulagao no software
em questao pode ser encontrado na Figura 23.

(a) (b)

Figura 23. Desenho da antena no CST. (a) com radome e (b) sem radome.
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3.1.1. Caracterizacao da antena RFID

O datasheet da antena transmissora nao providenciava informagdes
suficientes para o diagrama de radiacéo, visto que faltava escala e os parametros S
em funcdo da frequéncia. Com isso, viu-se necessario a producdo de uma
caracteriza¢do da antena baseada em medic¢des no laboratério da PUC.

Inicialmente, buscou-se comprovar que a polarizacdo era de fato circular
(secdo 3.1.1.1), posteriormente, obteve-se o0s parametros importantes (secdo
3.1.1.2) de uma antena. Para fins de comparacéo, feita na mesma secéo, essas
informacgdes obtidas provenientes de medic¢des e simulagdes no CST.

Por final, como no laboratério s6 tinhamos disponivel uma antena com
polarizacdo circular direita e esquerda, fez-se simulagcdes para comprovar a

polarizacéo cruzada neste sistema (secédo 3.1.1.3)

3.1.1.1. Polarizacao circular

A fim de comprovar a polarizagdo circular da antena, foram feitas as medigdes
usando a antena Yagi-Uda como transmissora, a pondo na posicdo horizontal
(Figura 24), vertical (Figura 25) e a 45 graus (Figura 26) e com isso obteve-se 0 S21

para esses trés sistemas usando o analisador vertical (Figura 27).

]
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Figura 25. Configuracéo Yagi vertical com PCR.

Figurg 26. Configuracdo Yagi a 45 graus.
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KEYSIGHT FieldFox Microwave Analyzer nessia 44GHz

e (8] Fi, 15 Nov 2019 6:00:08 AM

Figura 27. Analisador Vetorial.

Através deste equipamento, pode-se obter os parametros Sz1 nas situacdes
citadas acima, como esse dispositivo permitia a exportacdo do grafico num arquivo
.Csv, pode-se plota-los no Matlab, fazer uma comparacdo direta e comprovar que a

polarizacéo era de fato circular, como visto na Figura 28.

-20 : —— X:0.915 — X 0915
Y261 MG el
Mi
-30 - X: 0.915 7
Y: 2712
40 F //\ ]
a |
©
= 50 .
S YPCH
2 YPCV
YPC45
60 - .
N7
70 F .
-80 I I I 1 1
075 08 0.85 0.9 0.95 1 1.05

f (GHz)
Figura 28. Comparacéo entre os valores de S»; para as trés configuracdes.

Considerando erros de medic¢des, o local com perdas e outros fatores, admite-
se um erro de até 2.5 dB. E como visto na Figura 28, na faixa de frequéncia de 0.875

GHz - 0.915 GHz, sendo YPCH (Yagi horizontal com PCR), YPCV (Yagi vertical com
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PCR) e YPC45 (Yagi a 45 graus), pode-se notar diferencas abaixo do erro admitido.

Comprovando assim a polarizacao circular.

3.1.1.2. Parametros Importantes

-S11

S11
0 T T T T

S11 experimental
S5 S11 simulado A

10

-15

S11
)
o

-30

-35 1

0.75 0.8 0.85 0.9 0.95 1 1.05
f (GHz)

Figura 29. Comparacgéo entre valores simulados e experimentais de Sii.

Ao comparar o Si11 do experimental com o simulado, foi necessario somar
+2.1 dB ao experimental devido a perda no cabo, visto que o cabo tem
aproximadamente 2.5 metros e que, segundo o datasheet [32], a perda € de 12.3 dB
por 30 metros na frequéncia de 900 MHz. Com isso, pode-se observar semelhancas

entre os parametros onde a diferenca é aceitavel.

- S21 Hipotético

Como nao tinhamos duas antenas com polarizacao circular direita, que era o
método correto de se fazer, foi proposta outra abordagem para calcular o S21 da
antena RFID.

Obteve o0 Si1 da Yagi usando o analisador vetorial (Figura 30) e
posteriormente, montou-se dois sistemas YYH, Yagi-Uda;Yagi-Uda; ambas
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horizontais, (Figura 31) e YYV com as duas verticais obtendo assim seus S2i1 (Figura

32). Com isso, através da expressao de Friis, pode-se calcular o ganho da Yagi em

dois casos e compara-los (Figura 33) para minimizar os erros em calculos futuros.

S11

S11 Yagi

-10

12+

S11 (dB)

14t

18

_22 1 1 1 1 1 ]
0.75 0.8 0.85 0.9 0.95 1 1.05

f (GHz)
Figura 30. Si1 da antena Yagi.

!

gl

|

- Figura 31. Sistema Yagi-Ud;Yagi—UdverticaI.
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S$21
‘20 T T T T T

S21 YYH
S21YYV |

S21 (dB)

1 1 1

_65 L 1
0.75 0.8 0.85 0.9 0.95 1 1.05

f (GHz)
Figura 32. Comparagé&o entre os S21 das configuragdes vertical e horizontal.

Ganhos

Ganho (dB)

_10 1 Il 1
0.75 0.8 0.85 0.9 0.95 1 1.05

f (GHz)
Figura 33. Comparag¢éo dos ganhos das configurag8es vertical e horizontal.

Como o erro na faixa de frequéncia de 0.875 GHz - 0.900 GHz foi bem baixo,
pode-se usar os resultados experimentais com seguranga para a realizagdo dos

préximos célculos.
A préxima etapa foi medir o e S21 (Figura 34) do sistema Yagi-PCR em dois

casos, com a Yagi horizontal (Figura 24) e com a Yagi vertical em relacdo a PCR
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(Figura 25), visto que ja obteve-se o Si1 da PCR na secao anterior, foi possivel

assim obter os ganhos nos dois casos atraves da equacéao de Friis (Figura 35).

S21

S21 (dB)

_70 1 1 Il 1 1 ]
0.75 0.8 0.85 0.9 0.95 1 1.05

f (GHz)
Figura 34. Comparacéo entre os S21 das configuragfes Yagi-PCR horizontal e vertical.

Ganho
20

PCRH
15

10

Ganho (dB)
o

-10

-15

_20 L Il 1 1 1 1
0.75 0.8 0.85 0.9 0.95 1 1.05

f (GHz)
Figura 35. Comparagéo dos ganhos d as configuracfes Yagi-PCR horizontal e vertical.
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Como a diferenca entre os ganhos estimados, obtido através de calculos
matematicos sdo baixos em torno da frequéncia de 0.875 GHz - 0.915 GHz, os
resultados séo confiaveis.
A Ultima etapa foi estimar o S21 através da equacdo de Friis, visto que foi
possivel obter o ganho da PCR, agora num hipotético sistema PCR-PCR, pode-se

obter o S21 entre eles (Figura 36), foram feitas duas medi¢bes, uma com ganho da

YPH e outro com ganho da YPV.

S21

PCRH

S21 (dB)

-90 :
0.75 0.8 0.85 0.9 0.95 1 1.05

f (GHz)
Figura 36. Parametro S,; da PCR-PCR nos casos Yagi horizontal e vertical.

Como o ganho da Yagi H e Yagi V foram um pouco diferentes umas das
outras devido a possiveis erros na hora da medicdo e o mesmo para medi¢do do

ganho na PCR. Houve uma pequena distor¢do na banda de frequéncia da antena de

2.6 dB.
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- Diagrama de radiagao

90
TINY
4’
120 \' 120
150 150

180

180

Figura 38. Diagrama de radiagdo simulado.
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Diagrama de Radiacao

0 N T T T T gl
4
\3
5 F \ , 7 ,
\} 7
10 + \‘ -~ Y V4 4
¢ 4
\ ld RS Y3

15 ’ ~ .
. \\ ’ \ 'I
[a] \ P s \/a
T -20r \ s ‘l .
o ’
3
S -25 b
2
2 30 :
o

-35 b

-40 7

45 Simulado i

= = =Experimental
_50 1 1 1 1 1 1 1
0 45 90 135 180 225 270 315 360

0 (graus)
Figura 39. Comparagéo entre os diagramas simulado e experimental.

Foi possivel obter através do diagrama de radiacdo o ganho e o feixe de meia
poténcia (HPBW) das antenas, para o simulado encontrou-se 9 dB de ganho e o
HPBW de 65° e para experimental aproximadamente 10 dB de ganho e HPBW de
75°.

3.1.1.3. Comprovacgéao da Polarizagdo Cruzada

Como no laboratério s6 dispunhamos de uma antena com polarizacéo circular
direita e uma com esquerda, ndo era possivel obter o S21 de nenhuma das duas
experimentalmente (pode-se, com Yagi e PCR, obter o Sz da PCR-PCR
matematicamente, o que serd visto na proxima secao).

Entretanto, a fim de comprovar a utilizagcdo da formula de Friis, mais
exatamente do termo da multiplicacdo de perda de polarizacdo, mediu-se o S21 da
PCR-PCL (Figura 40) com analisador vetorial e plotou-se o Sii juntamente com S21
no Matlab (Figura 41).
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Figura 40. Configuracédo PCR - PCR.

Parametros S

T T T T T

SMpcr

S21 PCR-PCL | |

S21 (dB)

_70 1 1 | 1 1
0.75 0.8 0.85 0.9 0.95 1 1.05

f (GHz)
Figura 41. Pardmetros Si1 e Sz1 medidos nas configuracdes PCR-PCR e PCR-PCL.

Pode-se comprovar que na banda de 0.89 GHZ — 0.91 GHz, tanto S11 como
S21 ficaram abaixo de -30 dB, o que nao faria sentido se ambas fossem PCR. Ou
seja, comprova-se que nessa banda, obteve-se interferéncia destrutiva e o termo de

polarizacéo da expressao de Friis, ficou muito baixo.
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3.2.Tag

Projeto de Graduacao

A antena receptora (Figura 42) usada neste projeto, € fabricada pela
Datamars sendo do modelo FT301 NOVO UHF LaundryChip, operando na banda de

frequéncia 865 MHz - 928 MHz. Maiores informacdes podem ser encontradas na

Figura 43.

Figura 42. Tag utilizada.

Tag Dimensions (L x W x H)

Tag Weight (approx.)
Tag Materials

Tag Warranty

Tag Memory

Read Distance
Qperating Power
QOperating Frequency

Typical washing cycle

75x20x2.5mm
(2.95” x 0.79” x0.09")

70x 15x 2.5 mm
(2.75” x 0.59” x 0.09")

070g 0.70g
50/50 polycotton or full polyester

First of 200 wash cycles or 100 autoclave cycles or 3 years from ship
date

96 or 128* bits EPC (UL version only)

Up to 6 meters (up to 19 feets)

Passive, operates through antenna’s RF field
865 - 928 MHz

Washing: +90°C (194°F), IS minutes, 200 cycles

Drying: +180°C (356°F), 3 minutes, 200 cycles
Ironer: +200°C (392°F), 12 seconds, 10 seconds

Autoclave 3.2 bar, RH 85%, 5 minutes at 134°C (273°F)

Patching instructions +204°C (399°F), 12 seconds, 0.5 kg/cm2

Storage Temperature -40°C to +120°C (-40°F to +248°F)

Chemical Resistance All Chemicals common to the washing process

Compliance IS0/IEC 18000-6C EPC Class 1 Gen 2

Certifications OEKO-TEX® Standard 100 product class Il, MR Conditienal (1.5T - 3T)
Each transponder produced by Datamars is encoded with a unigue 96 bits EPC following GS1 standards. The
transponder code cannot be altered nor re-programmed. For customers willing to encode their own EPC,
Datamars provides custom coding services or a re-programmable transponder version named FT301 UL.

Standard Tag Pouch Material: 100% polyester

Dimensions: 27 x 80 mm (1.06" x 3.15")
Up to 4 colors embroidery

Custom sizes available

Minimum order quantities apply for customization

Figura 43. Parametros da tag [31].
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4. Estudo dos Metamateriais

4.1.Lente A

A primeira lente (mostrada na Figura 44) de metamaterial proposta neste
projeto apresenta uma interessante caracteristica: ela é insensivel a polariza¢éo, ou
seja, visto que a antena transmissora em questdo possui polarizacao circular, esta
lente possui as caracteristicas ideais para a solucdo de um dos problemas

apresentados no estado da arte.

TN

Figura 44. Primeira lente desenhada.

A lente em questdo mostrada com mais detalhes na Figura 45, possui 0s metais
(cobre) simetricamente espelhados em ambos os lados do substrato FR4. Para essa
estrutura, os patches podem ser vistos como uma combinacdo de linhas de transmissdo
capacitivamente carregadas com diferentes angulos de rotagdo. Os parametros geométricos

e 0s materiais usados podem ser encontrados na Tabela 2.
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W _
Ls
Figura 45. Visdes superior e lateral.
Tabela 2. Parametros da lente 1.
Material & Ty T R, L [l wW t Lg
(mm) (mm) (mm) (graus) (mm) (mm) (mm)
Condutor Cobre 1 - 0.018 0.35 4.2 10 0.3 - -
Substrato FR4 4.4 0.02 - - - - - 1.6 9.5
0 Parametros S
S11
5T S21 i
-10 F .
-15 F .
o
T -20r .
%)
25 1
-30 .
35+ .
_40 1 1 1 1 1 1 1 1 1
1 2 3 4 5 6 7 8 9 10

f (GHz)
Figura 46. Simulag&o dos Parametros S da lente A.
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Projeto de Graduacao

-15

S(dB)

-----

Freq(GHz)
Figura 47. Pardmetros S do artigo de referéncia [12].
Pode-se observar que a simulagéo feita no HFSS, quando comparada ao do

artigo em questéo, ficaram parecidas, apresentando uma ressonancia em torno da
frequéncia de 6.5 GHz.

4.1.1. Otimizacao da Lente A

Como citado anteriormente, a antena RFID opera na faixa de frequéncia de
902 MHz - 928 MHz, entdo foram propostas diversas mudancas na lente A a fim de
fazer com que a ressonancia estivesse nessa banda de interesse. Mudaram-se 0s

parametros da lente de acordo com a Tabela 3 e as figuras de cada mudanca sao
mostradas a sequir.

Tabela 3. Altera¢fes feitas nas lentes.
R (mm) W (mm) L (mm) Ly, (mm) [J(graus) Material
S.1 2.28 2 9.5 23.64 60 -
S.2 - - - - - Teflon
S.3 0.93 = 4.8 11.82 225 -
S.4 0.93 1 4.8 11.82 225 -
S5 2.09 1 9.5 23.64 30 =
S.6 2.2 2 9.5 23.64 30 -

4.1.1.1. Primeira Alteracao

Pode-se observar na Figura 49, uma ressonancia bem significativa perto da
frequéncia de 8 GHz, tendo o parametro S11 igual a aproximadamente -30 dB e 0 S21

préximo do 0 dB. Assim como uma excelente reflexdo em torno de 4.7 GHz, com S11
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perto do 0 dB e 0 S21 perto do -28 dB.

Figura 48. Lente da primeira alterac&o.

Parametros S

S (dB)

-35
f (GHz)
Figura 49. Parametros S da primeira alteragéo.

4.1.1.2. Segunda Alteragao

Como citado na Tabela 3, a segunda alteragdo ndo é necessaria introduzir

uma figura, visto que foi apenas mudado o material do substrato, em comparacao a

simulagé&o original do artigo.
Nesta segunda mudanca, observa-se pela Figura 50, uma ressonancia em 9

GHz, tendo S11 perto de -28 dB enquanto o Sz fica proximo do 0 dB.
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Parametros S

S (dB)

-25 7

-30 1 1 1 1 1 1 1 1 1

f (GHz)
Figura 50. Parametro S da segunda alteracao.

4.1.1.3. Terceira Alteracao

Nesta terceira mudanca, observa-se uma excelente reflexdo em torno de 5.8
GHz, tendo um parametro S21 perto dos -33 dB enquanto o Sii fica proximo de 0 dB,

como observado no gréfico da Figura 52.

N

Figura 51. Lente da terceira alteracéo.
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Parametros S

-35 1 1 1 1 1 1 1 1 1

f (GHz)
Figura 52. Parametros S da terceira alteracao.

4.1.1.4. Quarta Alteracéao

Nesta quarta mudanca, observa-se uma leve ressonancia em torno de 5.8
GHz, tendo um parametro Si1 perto dos -11 dB enquanto o S21 fica proximo de
-3 dB.

N

Figura 53. Lente da quarta alteragéo.
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Parametros S

1

21

10+

A5 -

-20

S (dB)

-25

-30

-35

_40 Il 1 1 Il 1 1 1 Il 1
1 2 3 4 5 6 7 8 9 10
f (GHz)
Figura 54. Parametros S da quarta alteracao.

4.1.1.5. Quinta Alteracao

Nesta quinta mudanca, observa-se uma acentuada ressonancia em torno de
6.8 GHz, tendo um parametro Si11 perto dos -17 dB enquanto o S2: fica proximo de
-0.5 dB.

N

Figura 55. Lente da quinta alterac&o.
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Parametros S
T

0 T T T T

S (dB)

f (GHz)
Figura 56. ParAmetros S da quinta alteracao.
4.1.1.6. Sexta Alteracéo

Nesta sexta mudanca, observa-se uma leve ressonancia em torno de 7.8

GHz, tendo um parametro Si1 perto dos -12 dB enquanto o Sz1 fica proximo de

-1 dB.

bl

Figura 57. Lente da sexta alteracao.
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Parametros S

S (dB)

-35 1 1 | I |

f (GHz)
Figura 58. Parametros S da sexta alteragéo.

Decidiu-se entdo mudar a lente por completo e essas mudancas estio especificadas

na Tabela 4 assim como as fotos de cada mudanca a seguir.

Tabela 4. Mudancas feitas nas lentes.
Mudanca
S.7 Retirado o cobre de uma das faces
S.8 Criado um circulo de raio igual a Ry, = 2.8 mm em seu centro

Criados cilindros em cada bola, de raio igual a R, = 0.1414 mm e

S.9

altura Hg;, = 1.6 mm

Criado um buraco no meio de raio Ry, = 0.86 mm e altura igual a
=10 Hpy = 1.6 + 0.036 mm
s 11 Duplicada a estrutura e distancia entre os dois condutores de H, =

4.75 mm
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4.1.1.7. Sétima Alteracao

Nesta sétima mudanca, ndo houve nenhuma resposta relevante.

Z
.

P

i RS

Figura 59. Lente da sétima alteragéo.

Parametros S
O T T T T T

T

1"

21

-10 b

-15 1 b

S (dB)

-25 b

-30 L 1 L 1 1 1 L 1 L

f (GHz)
Figura 60. Parametros S da sétima alteragéo.
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4.1.1.8. Oitava Alteracéao

Nesta oitava mudanca, também ndo houve nenhuma resposta relevante.

>
=

>¢\ ==

Figura 61. Lente da oitava alteracéo.

Parametros S

S (dB)

-30 1 1

f (GHz)
Figura 62. Parametros S da oitava alteracgéo.
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4.1.1.9. Nona alteracao

Nesta nona mudanga, também n&o houve nenhuma resposta relevante.

Figura 63. Lente da nona alteracéo.

Parametros S
O T T T T I

S (dB)

f (GHz)
Figura 64. Parametros S da nona alteracéo.
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4.1.1.10. Décima Alteracao

Nesta décima mudanca, observou-se uma leve ressonancia em torno de 6.5

GHz, este grafico dos parametros S ficaram bem proximo do artigo original [12].

Figura 65. Lente da décima alteragéo.

Parametros S
0 T T T T T

1

21

15 F 1

-20 - 1

S (dB)

-25 1 J

-30 1

-40 b

.45 | 1 1 ! I I 1 1 |

f (GHz)
Figura 66. Parametros S da décima alteragéo.
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4.1.1.11. Décima Primeira Alteracao

Nesta décima primeira mudanca, observou-se um deslocamento da

frequéncia de ressonancia que passou de 6.5 GHz para 5.8 GHz, porém com um Si1

maior que o do artigo original [12] ficando proximo de -6 dB, enquanto o Sz1, préximo
do -2.5 dB.

Figura 67. Lente da décima primeira alteragéo.

Parametros S
0 T T T T T T

S (dB)

f (GHz)
Figura 68. Parametros S da décima primeira alteracao.

Por ultimo, foi feito o escalonamento, como previsto na teoria de
escalonamento. Como Ultimas alteragbes, foram aplicados dois fatores de
escalonamento: primeiro de n1 = 0.1369 e o segundo de n2 = 0.1407 em toda a

figura para que assim deslocasse a ressonancia para a frequéncia desejada.
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Tabela 5. Escalonamento para o fator n;.

n1=0.1369
Material &, T, T R, L ] W t(mm) Ly
(mm) (mm) (mm) (graus) (mm) (mm)
Condutor  Cobre 1 - 0.132 2.557 30.679 10 2.191 - -
Substrato FR4 4.4 0.02 - - - - - 11.687 69.394

Tabela 6. Escalonamento para o fator n..

n2 =0.1407
Material Er Tg Tm Rc L theta W(mm) t(mm) Ls
(mm) (mm) (mm) (graus) (mm)
Condutor Cobre 1 - 0.128 2.488 29.851 10 2.132 - -
Substrato FR4 4.4 0.02 - - - - - 11.372 67.519

4.1.1.12. Décima Segunda Alteracao

Pode-se perceber diversas ressonancias, como por exemplo, de acordo com
a teoria, realmente a primeira ressonancia foi deslocada para 0.890 GHz, com S
valendo -11.92 dB e S21 valendo -2.543 dB, pode-se notar outra ressonancia

também em torno dos 4.5 GHz.

X:0.8878 Parametros S
0 r—Y:-2.543 T T
u \ W4
-5
-10 -
]
X:0.8878
Y:-11.92
o -20 -
)
5t |
S11
30 F |
S21
351 |
40 | i
-45 1 1 1 | 1 1 1 1 L
1 2 3 4 5 6 7 8 9 10

f (GHz)
Figura 69. Parametros S da décima segunda alteracao.
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4.1.1.13. Décima Terceira Alteracéo

Pode-se perceber uma leve ressonancia, em torno da banda de frequéncia de
0.900 GHz — 0.950 GHz

0 Parametros S

S (dB)

-40
075 08 08 09 09 1 105 11 115 12 125

f (GHz)
Figura 70. Pardmetros S da décima terceira alteracéo.

4.2.Lente B

Foi necesséria a introducdo de uma nova lente neste projeto, pois nao foi
possivel a tempo de TCC, otimizar a lente A para obter resultados positivos e
praticaveis. Com isso, uma nova lente foi proposta.

A lente em questdo, mostrada nas Figuras 71 e 72, diferentemente da
proposta anteriormente, € levemente sensivel a polarizagdo e possui a geometria
conhecida como cruz de Jerusalém. Ela consiste num par de dipolos em forma de I,
perpendiculares entre si e sdo usadas em diversos metamateriais [11]. O ponto
positivo desta lente é que é facilmente produzida, garante modos de ressonancia
simétricos (elétrico) e antissimétricos (magnético). Seus parametros geométricos e

0s materiais usados podem ser encontrados na Tabela 7.
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Figura 71. Visdo geral da lente B.

Ly | .

]

A

F'y
.

Lint
Hg
W L
Lsubs
Figura 72. Visao superior e lateral da lente B.
Tabela 7. Parametros da lente B.
Material €, Tg T, Hq W Lint L, Lsubs
(mm) (mm) (mm) (mm) (mm)
Condutor Cobre 1 - 014 - 2 18 15 -
Substrato FR 4 4.4 0.02 - 1.6 - - - 22.1
Outros Parametros g = 0.05 mm h, =13.2 mm

Pode-se observar comparando as Figuras 73 e 74 que a simulacdo feita no HFSS,
guando comparada ao do artigo em questédo, ficaram parecidas em magnitude, porém a
ressonéncia um pouco deslocada, onde a simulacdo apresenta em torno de 1.1 GHz,

enguanto a do artigo, em torno de 0.870 GHz .

73



\\ Projeto de Graduagao

DEPARTAMENTO
DE ENGENHARIA
ELETRICA

Parametros S
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Figura 73. Pardmetros S simulados da lente B.
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Frequéncia (MHz)

Figura 74. ParAmetros S do artigo [11].

4.2.1. Otimizacéo da Lente B

Como citado anteriormente, a antena RFID opera na faixa de frequéncia de

902 MHz — 928 MHz, entdo foram propostas diversas mudancas na lente B a fim de
fazer com que a ressonéancia estivesse nessa banda.

Inicialmente, mudou-se a estrutura e essas mudancas estdo especificadas na
Tabela 8 assim como as fotos de cada mudanca a seguir.
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Tabela 8. Mudancas na lente B.

Mudanca

S.1 Repetida a lente em todas as faces do substrato

S. 2 Foireplicado mais um substrato com apenas um condutor numa face
somente, com a mesma altura entre condutores de 13.2 mm

S. 3 Foireplicado mais um substrato com apenas um condutor numa face
somente (superior), com a mesma altura entre condutores de 13.2 mm

S.4 Mudou-se o Tc para 0.018 mm e o fr para 1 mm com 3 substratos sendo q o
Gltimo so6 tinha a cruz numa face

S.5 Diminui-se a altura entre os dois condutores em 10%, antes era 13.2 mm
agora € 11.88 mm

S.6 Aumentou-se a distéancia para 21.2 mm do original

4.2.1.1. Primeira Alteracéo

Nesta primeira mudancga, observa-se um deslocamento da frequéncia de 1.1
GHz para proximo de 1 GHz, porém com um Sii maior que o do artigo original [11],

ficando préximo de -8 dB, enquanto o Sz1, préximo do -2.5 dB.

Figura 75. Lente da primeira alteracéo.
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Figura 76. Parametros S da primeira alteragéo.

Segunda Alteracao

Nesta segunda mudanca, observam-se duas ressonancias, uma em torno de

1.1 GHz, tendo Si1 igual a -12 dB aproximadamente, e 0 S21 proximo de -7 dB. E a

segunda, em torno de 0.830 GHz, com Si1 igual a -13 dB aproximadamente e 0 Sz1

perto de -1 dB.

Figura 77. Lente da segunda alteracéo.
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Parametros S

S (dB)

1 1.1 1.2 1.3 1.4 1.5
f (GHz)
Figura 78. Parametros S da segunda alteracao.

0.8 0.9

-60

4.2.1.3. Terceira Alteracao

Parecida com a segunda mudanca, a terceira apresenta duas ressonancias

também, uma em torno de 1.15 GHz, tendo S1: igual a -12 dB aproximadamente, e 0
S21 proximo de -9 dB. E a segunda, em torno de 0.830 GHz, com Si:iigual a -17 dB

aproximadamente e 0 Sz1 perto de -1 dB.

Figura 79. Lente da terceira alteracéo.
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Parametros S
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Figura 80. Parametros S da terceira alteracao.

4.2.1.4. Quarta Alteragéo

Parecida com a segunda mudanca e terceira mudancga, a quarta apresenta
duas ressonancias também, uma em torno de 1.22 GHz, tendo Si: igual a -9 dB
aproximadamente, e 0 S21 proximo de -7 dB. E a segunda, em torno de 0.950 GHz,

com Si1 igual a- 15.5 dB aproximadamente e o S21 perto de -2 dB.

Figura 81. Lente da quarta alteracéo.
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Parametros S
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f (GHz)
Figura 82. Parametros S da quarta alteracéao.

4.2.1.5. Quinta Alteracéo

A quinta mudanca, assim como citado na tabela, consiste apenas na mudanca
de altura entre os substratos, com uma diminuicdo de 10% do anterior, sendo assim,

nao se vé necessidade de adicionar outra figura, mas penas os resultados dos

parametros S.
Nesta quinta alteracdo, pode-se observar uma ressonancia em torno de 1.15

GHz com o parametro Si1 em torno de -10 dB e S21 em torno de -2 dB.

79



\\ Projeto de Graduagao

DEPARTAMENTO
DE ENGENHARIA
ELETRICA

Parametros S
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Figura 83. Parametros S da quinta alteracao.

4.2.1.6. Sexta Alteracao

A sexta mudanca, assim como citado na Tabela 8, consiste apenas na
mudanca de altura entre os substratos, com um aumento de 60% do original, sendo
assim, ndo se vé necessidade de adicionar outra figura, mas apenas os resultados
dos parametros S.

Nesta sexta alteracdo, pode-se observar uma ressonancia em torno de 0.95

GHz com o parametro Si1 em torno de -18 dB e S21 em torno de -1 dB.
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Parametros S
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Figura 84. Parametros S da sexta alteracao.
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Figura 85. Fase dos parametros S da sexta alteracao.
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Permeabilidade Magnética
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Figura 86. Permeabilidade Magnética real e imaginaria para a sexta alteracgéo.
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Figura 87. Permissividade Elétrica real e imaginaria para a sexta alteracao.
Os gréficos das Figuras 86 e 87 foram feitos a partir das equacgdes para o

calculo de p e L presentes em [33].
Pode-se observar que na banda de frequéncia de operagdo de RFID, essa
lente se comporta como o esperado de um metamaterial, com os valores para

permeabilidade magnética e permissividade elétrica negativos.
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4.2.1.7. Sétima Alteracao

Foi entdo feito o escalonamento dos parametros. Como previsto na teoria de

escalonamento, foi aplicado um fator de n = 0.8318 em toda a figura para que assim

deslocasse a ressonancia para a frequéncia desejada.

Tabela 9. Parametros escalonados da lente B.

Material & T, T, H, W Lint L, Lsubs
(mm) (mm) (mm) (mm) (mm)
Condutor  Cobre 1 - 0.168 - 2.404 21.639 18.033 -
Substrato FR4 4.4 0.02 - 1.923 - - - 26.569
Outros Parametros g = 0.0601 mm h,, = 15.869 mm

Nesta ultima alteracdo, assim como previsto na teoria de escalonamento,
pode-se mover a simulagcdo do artigo original [11] para a frequéncia desejada de

aproximadamente 0.915 GHz, tendo um Si1 proximo de -8 dB e um Sz1 proximo de

-2 dB.

Parametros S

S (dB)

1 1

-50 I 1 I 1 1
0.8 0.9 1 1.1 1.2 1.3 1.4 1.5

f (GHz)
Figura 88. Parametros S da sétima alteracao.
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5. Experimentos e Resultados

5.1.Antena e lente A

Como a lente A ao ser otimizada para a frequéncia da antena transmissora
nao apresentou uma aplicacado pratica, visto que a espessura do substrato em
questdo ficou préoxima de 11.32 mm, deixou-se essa simulacdo para trabalhos

futuros.

5.2.Antena e lente B

A lente B, otimizada, escolhida para simular o sistema antena e lente, foi a da

sexta alteracao (secao 4.1.2.6), os resultados podem ser encontrados a segulir.

Figura 89. Desenho da antena com a lente otimizada.
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Figura 90. Pardmetro Si; da simulacdo antena + lente otimizada.

180

Figura 91. Diagrama de radiagéo simulada do sistema antena + lente otimizada.

O ganho obtido com essa nova lente foi em torno de 10.9 dBi e o feixe de

meia poténcia foi aproximadamente 46.4 graus.
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5.3.Comparacao de Resultados com e sem Lente

Pode-se ver pela Figura 92 que o parametro S11 ao se utilizar a lente

apresentou melhores valores para a faixa de frequéncia de interesse.

S11
0 T T T
Sem Lente
Com Lente
5+ B
-10 - b
)
o
“_’ -15 b
»
-20 b
-25 b
_30 1 1 1 1 Il
0.75 0.8 0.85 0.9 0.95 1 1.05
f (GHz)

Figura 92. Comparagéo do S11 para o sistema com lente e sem.
Também ¢é possivel verificar pelas Figuras 93 e 94 que a diretividade do

sistema com a lente é melhor.

180
(b)

Figura 93. Comparacéo entre os diagramas de radiacao. (a) sem lente e (b) com lente.
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o Diagrama de Radiacao
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~
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Figura 94. Comparacdo entre os diagramas de radiacdo dos sistemas com e sem lente.
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6. Conclusao e Trabalhos Futuros

Foi possivel caracterizar a antena RFID presente no laboratério da PUC,
obtendo seus parametros mais importantes com precisdo. Alguns resultados, porém,
tiverem uma pequena margem de erro devido a erros de medicdo por falta de um
ambiente anecoico adequado.

POde-se observar, ao decorrer do curto tempo para esse projeto, que a

7

otimizacdo de lentes € um processo longo e que demanda também tecnologia
avancada no computador para realizar simulacdes de maior demanda.

A lente B foi projetada e otimizada com sucesso e pdde-se observar que o
sistema antena e lente B ao ser otimizado para a faixa de frequéncia apresentou
melhorias. O parametro Si1 (Figura 92), apresentou aproximadamente -23 dB com a
lente e sem a lente -29 dB, a diretividade (Figura 93), apresentou um HPBW de 46.4
graus enquanto sem a lente tinha 65 graus, e para o ganho, apresentando um ganho
de 10.9 dBi com a lente enquanto sem a lente apresentava 9 dBi.

Para trabalhos futuros, como a Lente A foi projetada pra trabalhar em alta
frequéncia, a otimizacdo feita para ela neste projeto ndo apresentou resultados
relevantes, com isso, outros procedimentos podem ser aplicados como transformar
as linhas de transmissdo em circuitos para que assim possa ter uma analise mais
analitica do sistema e com isso, adicionar capacitores nos slabs de cada patch.

Visando assim, otimiza-la para a banda RFID.
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Apéndice

Apéndice A — Tutorial do HFSS

1. Acessando o HFSS

Passo 1: Apés iniciar o programa, clicar no icone “HFSS”, localizado na barra

superior como mostrado na Figura 1 e depois em “Insert HFSS design”.

R N HFSS d3D Curcunt Icepak Maxwell <
Y, Paste X Delfte - -

g Insert HFSS design
Insert HFSS design

2. Conhecendo a area de trabalho do HFSS

CEL)
600
oon
ws 0
re/

- (5] Projects®

5 b HFSSDesign1 (Driventodal) 1o us

0 1 2(mm) _Components |

Message Manager 2 f Progress
[+ T3 Project3 (C/Users/Ricardo Documents/ Anscft/)

(1) Project Manager - Caixa onde fica localizado o seu projeto, nela vocé pode
acessar diretamente configuracdes e resultados da sua simulagao.

(2) Barra de ferramentas onde te permite esconder e mostrar as figuras que vocé
desenhou, facilitando a visualizacdo e selecao de faces.

(3) Barra de ferramentas com as opcdes de rotacionar (€ possivel fazer isso

diretamente apertando e segurando o botdo de “scroll’ do mouse), dar zoom
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(também pode ser realizado rodando o “scroll” do mouse), e orientar sua figura,

ajudando na visualizac&o do desenho.

(4) Barra de ferramentas que te permite centralizar sua figura na tela, util caso vocé
insira tamanhos absurdos sem querer e sua figura acabe saindo da é&rea de
visualizacéao.

(5) Barra de ferramentas que te permite selecionar o tipo de figura que vocé deseja
desenhar, existem figuras 3D, 2D e 1D.

(6) Barra de ferramentas onde encontram-se as op¢des unir e subtrair uma figura de
outra. Ajuda por exemplo, na hora de desenhar uma casca cilindrica, onde vocé
deseja subtrair um cilindro do outro, ou quando se deseja que ndo tenham
intersecdo de figuras, Gtil pois se houver duas figuras no mesmo espaco, Vocé nao
ird conseguir validar sua simulagéo.

(7) Model Editor Tree - Caixa onde se encontram as figuras que vocé ira desenhar.
E possivel acessar as figuras diretamente por esse menu.

(8) Properties - Caixa de propriedades da figura selecionada em (7), nela vocé pode
mudar parametros como comprimento, largura, espessura e posicao.

(9) Messenger Manager - Caixa onde aparecerdo possiveis erros de validacéo,
simulacdo e mensagens de simulacao completa.

(10) Model Editor Graphics — Area do HFSS onde vocé ira desenhar a figura de
interesse.

(11) Progress Windows — Caixa onde mostra a etapa em que a simulacdo se

encontra e o progresso dela.

3. Desenhando sua Lente

Nosso objetivo:
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O Substrato

Passo 2: Apos ter conhecido o HFSS, selecionar a figura que vocé quer comecar a
desenhar no Model Editor Tree. Nesse tutorial, foi escolhido um paralelepipedo.

1z, Coordinate Systems
& Planes Z
& Lists 3

Hold 'X','¥!, or 'Z' key to constrain relative/hovement.

Using F3/F% to toggle betueen point and diafdf emtrgm

Use context menu to choose In Plane movemer(:. 1 2 (mm)

Passo 3: substrato desenhado.

2 (mm)
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Passo 4: No menu Properties, selecionar o material do substrato.

Properties a3 X
Name I Value I Unit IEvaIuated Valuﬂ
Name Box1
Material "vacuum" v "vacuum"
Solve Inside |Edit... V
SRR La_
Model v
Group ‘Mode
Display Wi... [
Material A... [
Color B = ]
Transparert | 0 |

Agtribute | Command |

Select Definition X

Materials | Material Fiters |

Search Parameters -
Search by Name i~ Search Criteria - Libraries ¥ Show Project definions [~ Show all libraries
| & by Name " by Property | |[sys] AmoldMagnetics A
I [sys] ChinaSteel
S ‘ lP.eFatwc— Pemmittivity ;] ‘ fyﬂ F:La_"fﬁ"d_'_ v
Relative Relative BA
Name Localioe Qrigin Permittivity Permeability Cond
SysLibrary Materials 1 1.00018 1820000sien
SysLibrary Materials 1 1 18200000sie
T (N (I O
vacuum SysLibrary Materials 1 1 0
| water_distilled SysLibrary Materials 81 0.999991 10.0002sieme
| water_fresh SysLibrary Materials 81 0.999991 0.01siemens.
| water_sea SysLibrary Materials 81 0.999991 4siemens/m
| |ZEONEX RS420 gm) SysLibrary Materials 23 1 0
| ZEONEX RS420-LDS ¢m) SysLibrary Materials 21 1 0
| zinc SysLibrary Materials 1 1 16700000sie
N zirconium SysLibrary Materials 1 1 ‘244000003ie 3
< >
View/Edit Materials... Add Material.... Clone Material(s) Remove Material(s) I Export to Library... l

0K | Cancel ] Help J

Passo 5: Pode-se selecionar uma cor para 0 seu substrato, para ajudar na

organizacao do desenho.
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Properties a x Color X
Name Value | Unt [ Evaluated Value |

Name Box1 E l_ - [_ r—

Material "vacuum" “vacuum" EFEEN

Solve Inside v EEEEEN \

Orientation  Global EEEEN

Model 2 EEEEN

Gowp | Model EET N

Display Wi.. [~

lasia A, — NN _ :
e | EEEEEEEN Hoe:B0 Red:[143

‘Transparent U R Sa:w Gneen:lﬁ

Reset Custom Colors to Defaults l Color Lum:m Blue: [143
Attribute [ Command | OK I Cancel I Add to Custom Colors |

Passo 6: Para alterar os parametros do objeto desenhado, primeiro o selecione o

objeto no Model Editor Tree e depois va em Properties.

Project Manager 7 x @l B4 Model
= Project3* 54 Solids
£ HFSSDesign1 (DrivenModal)* =4 FRA_epoxy
é 3D Components E]._;_/' Box1
%8 Model LD
(28] Circuit Elements @l
.9 Boundaries -4 Planes
.. Excitations -2 Lists
ﬁ Hybrid Regions
..B8 Mesh Operations
}? Analysis
@ Optimetrics
-[F] Results
--[1] Port Field Display
ﬁ Field Overlays
.5 Radiation
@-(Z]) Definitions

Properties o x

Name I Value I Unit I Evaluated Value
Command | CreateBox
Coordinate.... Global

Poston |-0.8.0.8.0 mm -0.8mm , -0.8m..
XSize 16 mm 1.6mm
YSize 16 mm 1.6mm
ZSize 04 mm 0.4mm

Passo 7: Para facilitar, é possivel adicionar variaveis no HFSS ao invés de trocar os
valores toda vez que for necessario. Para isso, vd em HFSS>Design Properties e
clicar em Add.
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,‘-l,. ANSYS Electronics Desktop 2019 R2 - Project3 - HFSSDesign1 - 3D Modeler - [Project3 - HFSSDesign1 -
i File Edit View Project Draw Modeler HFSS Tools Window Help

H I % Cut ¥ Undo  Select: Object  + Solution Type...
y Cop pedo (8 Select by Name List... et
SaVe [ paste X Delete &% Validation Check...
Desktop View Draw Model Simi ) Gnabyze Al
Submit Job... —
Project Manager % e
tes...
= ProjeitT" B Edit Notes,
(£-§ HFSSDesign1 (DrivenModal)* Toolkit >
é 3D Components
% Model 3D Model Editor
@ Circuit Elements Set Object Temperature...
g Boundaries Design Settings...
A2 Excitations
.. &P Hybrid Regions Model 4
B8 Mesh Operations Boundaries >
&P Analysis Excitations >
Optimetrics Hybrid 5
-[¥] Results )
Port Field Display Mesh Operations 2
ﬁ Field Overlays Analysis Setup >
----- Radiation Optimetrics Analysis >
-] Definitions Fields N
Properties Radiation >
>
Name | Value | Unit I Eva Bl
Command  CreateBox Boundary Display (Solver View)
Coordinate... Global 7 =
— Design Properties...
Posttion 08.08.0 mm -0.8n 5
XSize 16 B 16m Design Datasets...
YSize 16 mm 1 6mm ]l|
Properties: Project3 - HFSSDesign1 X
Local Variables |
' Value " Optimization / Design of Experiments " Tuning (" Senstivity " Statistics
I Name | Value | Unit I Evaluated Value Type Description ] Read-only I Hidden
< >
- [V Show Hidden
Add... | Add Aray... Edit Bemove Y
0K Cancel

Na nova caixa inserir o nome da variavel e seu valor.
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Add Property X

M ame 1Lm {* “ariable ™ Separator ¢ PostProcessing ariable
" Amaylndest ariable

Unit Type {None lJ Units LJ

Walue (221 |

Enter initial value into Yalue field. Thiz should be a number, variable, or expression. Referenced project variables should be prefised with a '$'. Examples;
22 4pF. $C1, Zcos($x).

Ok | Cancel ]

Passo 8: o HFSS trabalha com posi¢des, portanto, ao desenhar algo livremente, n&o
podera mové-lo com o mouse. Serd necessario alterar as suas coordenadas X,Y,Z
no menu Properties.

Project Manager 2 x il 5-gh Model
=] Project3* B Solids 2
&} HFSSDesign1 (DrivenModal)* -4 FR4_epoxy
& 30 Components =& Boxl
@ Model © CreateBox
(28] Circuit Elements @-le, Coordinate Systems
¥ Boundaries [#-4B Planes
# Excitations @€ Lists

& Hybrid Regions
BB Mesh Operations

S Analysis

@ Optimetrics
ts
b
<% Radiation
-2 Definitions
Properties 2 x
Name | Value [ Unt [ Evaluated Value |
Command  CreateBox
Coomdinate  Clobal
I Position |mm -0.8mm , -0.8m. I
; T— T
YSize Lm 22.1mm
ZSze  [thick 1.6mm

Passo 9: para desenhar o condutor, primeiro faremos ele 2d e depois adicionaremos
uma espessura. Novamente, no Model Editor Tree, iremos adicionar a forma
desejada.
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Hold 'X', '¥!, or 'Z! key to constrain relative movement. &(
Using F3/F4 to toggle between point and dialog entry mode.

Use context menu to choose In Plane movement.

Passo 10: Depois iremos alterar seu tamanho, conforme feito no passo 6.

Project Manager R x \ =] ‘?ﬂs Model
=] mtmnovo* E} ‘_7 Solids
-3 novo mtm (DrivenModal)* -4 FR4_epoxy

é 3D Components =& Box1
“@ Model H a CreateBox
@ Circuit Elements -3 Sheets
¥ Boundaries S
9 Excitations =-E3 Rectanglel

&P Hybrid Regions

S} CreateRectangle

B8 Mesh Operations overLines
& Analysis -1z, Coordinate Systems

@ Optimetrics +-4F Planes

Results | [+ @ Lists

Port Field Display
ﬁ Field Overlays
? Radiation
[#-[Z2 Definitions

Properties B X
Name | Value ] Unit ] Evaluated Value I
Command CreateRectangle
Coordinate...| Global
Position 00.16 mm Omm , Omm , 1....
Axis z
XSize -10 mm -10mm
YSize 2 mm -2mm
A Al

Passo 11: Iremos repetir o procedimento para adicionar um segundo retangulo
condutor.
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é_._

Hold 'X', '¥!', or 'Z!' key to constrain relative movement. *(

Hainag FR/FY ta tannle hetueen nnint and dialne entru mnde

Passo 12: Ao selecionar o segundo retangulo e inserir seus parametros, eles irdo se
sobrepor, serd necessario checar a posicdo que se encontra o topo do primeiro e
mover o0 segundo para ficar no local desejado. Para isso, devemos clicar com o

botéo direito sobre o retangulo e selecionar Measure>Position.

Next Behind
Selection Mode >
Select Objects >

Reference coordinate system is Global

et : Position 1{Reference) = [0, 0, 0jmm
o L)
S Position2(EdgeCenter_78) = (-9, 0, 1.6Jmm
Go to History
: Distance = 9. m
Measure > @ Position X Distance = 9mm
View > f: = Y Distance = Omm
i ace .
Edit o Z Distance = -1.6mm
Group >

Create 3D Component..

Assign Material

Create Array ..

Create Open Region ..

Update Open Region Padding...

Assign Boundary
s Assign Excitation
Assign Hybrid

Assign Mesh Operation

3 X § Progress

Plot Fields

Plot Mesh.

Plot VRT > 1
| Close
Copy Image |

A esquerda da tela ira aparecer a posicdo que se encontra o segundo retangulo.
Tendo essa informacéo, podemos alterar sua posicéo para a desejada indo no menu

Properties.
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Passo 13: Para inserir outro retangulo, podemos utilizar as opg¢des de copiar e colar,
ao clicar com o botao direito do mouse sobre a figura. Ele sera inserido exatamente
em cima do original, e no box do Model Editor Tree, aparecera um novo retangulo.

_ Next Behind 8
Selection Mode >
Select Objects >
Extend Selection >
Go to History
Measure 5
View >
Lk > 43 Copy CtrlsC
Group 5 B Paste Ctrl+V
Create 3D Component... X Delete Delete
2| Assign Material... Froperfies.

LL | | CreateAmay.. Arange 5
Create Open Region ... Duplicate >
Update Open Region Padding... Scale
Assign Boundary S Surface >
Assign Excitation > Boolean >

= P Assign Hybrid > Sweep " r—
Assign Mesh Operation > Dt o
Plot Fields >
Plot Mesh..
Plot VRT >
Copy Image
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Projeto

Project Manager 3 x

=] mtmnovo*

-3 novo mtm (DriventModal)*
6 3D Components
& Mode!

@ Circuit Elements
¥ Boundaries

A9 Excitations

ﬁ Hybrid Regions
B8 Mesh Operations
ﬁ Analysis

@ Optimetrics
Results

[ Port Field Display
'h Field Overlays
? Radiation

-2 Definitions

Properties a x

Value
Rectangle3
Orientation | Global
Model
Group
Display Wi..
Material A...
Color e
T 0 [

Name | I Unit [EvaluatedValuel

Name

K

Model

O

Atribute | Command |

B4 Model
B Solids
| 4% FR4_epoxy
-7 Boxl
i 1 a CreateBox
=-3 Sheets
=3 Unassigned
=3 Rectanglel
1 CreateRectangle
-~ Coverlines
-3 Rectangle2

- Coverlines
-1z, Coordinate Systems
-4 Planes

w2 Lists

Passo 14: ApOs posicionar o terceiro

de Graduacao

retdngulo para o local desejado, vamos

selecionar todos os condutores e uni-los, assim garantiremos que ndo estara

havendo interse¢cdo entre eles. Podemos selecionar todas as formas através do

Model Editor Tree ou clicando no desenho ao pressionar a tecla “ctrl”.

Apos selecionar as formas iremos na barra superior, clicar na opcao Unite.

@A 5| m@|\ | & BMove |fgAlengLline ‘ Unite | [ Split B | @ rinet
8 Q 9 Al il EE}Rotate ﬁ?Around Axis | R Subtract [ Imprint B | @ chame
me RO L\ A g Mirror | Gl ThruMirror | [@ Intersect E

er

j Surface ~
<> Sheet -

\, Edge ~

v Relative €S » 5@ Measure ~

w Face CS

¥, Object S ~

o= Ruler

Units
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Passo 15: vamos agora adicionar uma espessura ao condutor. Devemos clicar com

0 botdo direito sobre a forma e selecionar Edit>Surface>Thicken Sheet.

[PERRTRv e

= “ Most Recently Usec

[ﬂ é HFSS Components
Nt Bt 5 {23 Antennas
ext Behin 2
Selection Mode > {3 Johanson
. {_3 Modelithics 3D
Select Objects > 3 Rectangular W:
Extend Selection > {23 Surface Mount
{3 TDK
Go to History
Measure >
View >
Edit > 53 Copy Ctrl+C | y
Group N [ Paste Ctrl+V
Create 3D Component... X Delete Delete
M  Assign Material... Eropeibies.
Create Array ... Arrange >
Create Open Region ... Puplicate ?
Update Open Region Padding... Saale
Assign Boundary s Surface > Section...
Assign Excitation s Boolean > Connect
; Assign Hybrid > Sweep > Cover Faces
Assign Mesh Operation > Delete Last Operation Uncover Faces
Plot Fields > Detach Faces
Create Object From Face
Plot Mesh...
Cover Lines -
Plot VRT >
BT TR T S L R Lt Move Eacis > F
ess
Comyimage Sweep Faces Along Normal
Thicken Sheet...
Wrap Sheet
Project Sheet...

Na nova janela que aparecera escolher a espessura desejada.
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[, Thicken Sheet X

B lfw ]

[~ Both Sides

o]

Thickness:

Cancel I

I

Agora que vocé deu uma altura, é possivel selecionar qual tipo de material vocé quer

utilizar, como por exemplo, o cobre.

Passo 16: vamos duplicar esse condutor e rotaciona-lo para que fique perpendicular
ao primeiro. Com o botéo direito sobre a figura selecionar Edit>Duplicate>Around

Axis. Apoés feito isso, vamos unir para que ndo haja problema de intersecéao.

131
= B!
1
{
1
i
£
Next Behind B B
Selection Mode > {
Select Objects >
Extend Selection >
Go to History
Measure > _-37
View >
Ll > Ga Copy Ctrl+C
Group 5 [ Paste Ctrl+V
Create 3D Component... X Delete Delete
&  Assign Material... Properties...
Create Array ... Arrange >
Create Oper fhg Along Line Duplicate >
Update Ope t7 Around Axis... Scale
i Mirror
Assign B y Surface >
Assign Excitation > Boolean >
Assign Hybrid > Sweep s
Assign Mesh Operation > Delete Last Opecation .
Plot Fields > E
55
Plot Mesh...
Plot VRT >
Copy Image
',ﬁi Duplicate Around Axis b4
Bis R O
Angle; 0 -| [ 4= =
9

Tatal number: |2 j

Attach To Original Object: T

o]

MOTE: “when ‘Attach to Ornginal Object’ is selected.
face/edge azzignments (2.9, boundaries/excitations]
ion duplicates will be last, ta ensure model
|consistency, when 'Total Mumber' iz edited.

Caticel
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Passo 17: como no nosso projeto desejamos dois objetos iguais a este, basta copia-
los e mové-los para baixo. Apos feito isso, inserimos um pouco de transparéncia
para observar se a estrutura esté correta, selecionando o objeto e alterando a opc¢éo

Transparent no menu Properties.

=48 Model
-7 Solids
E S copper
o 4 FR4_epo: Expand All
& Collapse All
Iz, Coordinate Syst

H Select >
43 Planes
a2 Lists Edit > 53 Copy Ctrl+C
Group , B Paste Ctrl+V
Create 3D Component... X Delete Delete
& Assign Material... Properties...
View N Arrange 5
Properties... Duplicate >
Create Array ... Scale
Create Open Region ... Surface >
Update Open Region Padding... Boolean 5
Assign Boundary N Sweep >
Assign Excitation > Delete Last Operation
Assign Hybrid >
Assign Mesh Operation >
Plot Fields >
Plot Mesh...
Plot VRT >

105



)}

)iDEE

Projeto de Graduacao

DEPARTAMENTO
DE ENGENHARIA
ELETRICA
Project Manager 4 x fl 59 Model
=-{¥] mtmnovo* £ Solids
I @ novo mtm (Driventodal)* = @ copper
&5 30 Components @ & Rectangle3
@ Model 5P Rectangled
2 Crait Bements. 1 CreateRectangle
£ Boundaries B Coverlines
9 Excitations =T Unite
& Hybrid Regons 5@ RectangleS
& Mesh Operatons —1 CreateRectangle
5P Anslyss
{8 optimetrics
B3] Resuits
{3 Port Field Display
T Field Overlays. == ThickenSheet
¥ Radaton ! DuplicateAroundAxis
51 (2] Definitions =-Th Unite
&P Rectangle3 2
Properbes dux ! DuplicateBodyAroundAxis
Name Vave [ Unt_| Evakuated Vae | i Eie
Name  Baxl
e . TR ey’ CreateBox
Solve ke % @ L. Coordinate Systems
O [kt @ Planes
Model ~ @€ Lists
Gow Model
Display Wi [
Matensl A r
Color
[ o)
atute |

Para conferir se sua montagem esta correta, verifique as distancias (visto no passo

12).

Esté tudo OK! A lente esté pronta!

Simulacgéo

a) Adicionando regido

Passo 18: Primeiro devemos ir na barra superior e inserir uma regido. Selecionamos

o tipo para absoluto para ficar mais facil.
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vy

@ a - @® \ d @ |@EMove E},ﬂ—!-amg Line | (@ Unite
i 8 Q L_J Al I ] D‘?F&:ztate E]?»«!:"_HL'J—&!S B, Subtract [
@ e R X A | s Mirror | g Thru Mirror | [ Intersect
[ Create region
Create region
% Region X

Padding Data: % Pad all directions similarly
" pad individual directions
" Transverse padding

Direction Padding type l Value I Units I
Al |Percentage Offset L] 0
Percentage Offset
Absolute O

[™ Save as default

=48 Model

=4 Solids
4% copper
-4 FR4_epoxy

-4 vacuum
=57 Region
") CreateRegion
-
+-42 Planes

-2 Lists

b) adicionando o tipo de porta floquet
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Passo 19: precisa-se selecionar uma face para definir seu tipo de simulacdo. Nesse

caso é de floquet port. Devemos clicar com o botédo direto sobre o desenho e ir em

Selection Mode>Faces.

Next Behind ) RN

Selection Mode > Groups G

Select Objects > Submodels U

Extend Selection > Objects (o]

Go to History @ Faces F

Measure > Fdges 2
Vertices v

e > Ml M

i >
EdiE Mt Mode Setings..

Group >
Create 3D Component...
& Assign Material...

Create Array ..

Create Open Region ...

Update Open Region Padding...

Assign Boundary >

Assign Excitation > Y

Assign Hybrid >
NN

Assign Mesh Operation >

Plot Fields >

Plot Mesh...

Plot VRT >

Copy Image

Passo 20: clicando com o botdo direito na face selecionada ir em Assign
Excitation>Floquet Port. Vai abrir o menu da floquet port, com isso precisamos

definir um novo vetor.
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Next Behind
Selection Mode
Select Objects
Extend Selection

Go to History

Measure

View >
Edit >
Group >

Create 3D Component...

Projeto de Graduacao

Circuit Port...
Floquet Port...
Lumped Port...
Terminal

Wave Port...
Incident Wave
Linked Field
Voltage...
Current...

Magnetic Bias...

Multipaction Charge Region...

Multipaction DC Bias...

&  Assign Material..

Create Array ...

%, § Progress Create Open Region ...
Update Open Region Padding...
Assign Boundary >
Assign Excitation >
Assign Hybrid >
Assign Mesh Operation >
Plot Fields >
Plot Mesh...
Plot VRT >
Copy Image

[&] Hide 0 Me

Floquet Port : General

Mame: FloquetPort 1

i~ Lattice Coordinate System -

A Direction:  [Undefined ~|

LUndefined
B Direction:

Passo 21:. apos clicar em New Vector, vocé podera escolher aonde ele sera

posicionado.
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Hold 'X',1¥!', or 'Z! key to constrain relative movement.

Use context menu to choose In Plane movement.
=47 Region

Floquet Port : General X

Name: |EEEEEIN]

Lattice Coordinate System -

A Direction: [Defined >
B Direction: [Undefined ~

k[ Nea> Cancel P xIPmnvess

Passo 22: repetir o mesmo processo para o segundo vetor (B Direction), de modo

que ele fique perpendicular ao primeiro.
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Hold 'X', '¥!, or 'Z! key to constrain relative movement.

Use context menu to choose In Plane movement.
24P Solids X
4% copper f 3
B FR4_epoxy
=-4% vacuum
-4 Region
o

Floquet Port : General

Name:

Lattice Coordinate System

A Direction: | Defined -
B Direction: |Defined -

k | Next > I Cancel | [ x # Progress

Passo 23: apés definidos e posicionados os dois vetores de floquet da porta 1, clicar

em Next para selecionar os modos de onda, nesse caso, sO selecionaremos um

(TE).

111



\\ Projeto de Graduagao

DEPARTAMENTO
DE ENGENHARIA
ELETRICA

Floquet Port : Modes Setup X

Number of Modes: |1

{Please click on this button if you want assistance in setting up modes.)

Modes Calculator... |

Mode Polarization State I m | n I Attenuation (db/ength)
1 TE 0 0 0.00

™ Filter modes for reporter

I Next > I Cancel l

Passo 24: ap0s ter selecionado o modo de onda, ir para a proxima janela para
configurar o Deembed, que faz com que a face da caixa de simulagéo desloque para

em cima da lente, garantindo assim que nédo ha perda na forma da onda.
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Floquet Port : Post Processing X

—Deembed Settings

¥ Deembed Distance: 11 0 ]mm __v_J

Positive distance will deembed the port into the model.

Get Distance Graphically... ‘

Use Defaults

< Back Mext > Cancel I

Passo 25: finalizar e repetir os passos 2 a 6, porém na face oposta a essa.
c) Adicionando Master e Slave
(permite a multiplicacdo da estrutura em volta do espaco, ja apresentando o

resultado de uma simulagao de “N” lentes)

Passo 26: primeiro € necessario selecionar uma outra face, onde vocé deseja que

tenham as N repeticdes.
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Projeto de Graduacao

Passo 27: vA ao master clicando com botdo direito e selecionando Assign

Bounderies>Master.

igress

Next Behind
Selection Mode
Select Objects

Extend Selection

Go to History

Measure

View

Edit

Group

Create 3D Component...

Assign Material...

Create Array ...

Create Open Region ...
Update Open Region Padding...

Assign Boundary
Assign Excitation
Assign Hybrid

Assign Mesh Operation

Plot Fields
Plot Mesh...
Plot VRT

Copy Image
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Anisotropic Impedance...

Aperture...

Finite Conductivity...
Half Space...
Impedance...
Layered Impedance...
Linked Impedance...
Lumped RLC...
Master...

Perfect E...

Perfect H...
Radiation...

Slave...

Symmetry...

Fresnel (SBR+)

PML Setup Wizard...

AY

1l Hide 0
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Master Boundary

Name: |Masterl

- Coordinate System

U Vector: |Undefined v

ndefined

New Vector,
SR

WV Vector:

0K I Cancel

Passo 38: assim como feito para a Floquet Port, vocé deve por o vetor U vertical. O
vetor V ja ira aparecer perpendicular ao U, s sera necessario escolher se ele sera
reverso ou néo (isso pode ser observado pela figura, no nosso caso nao foi preciso,

pois 0 V j& ficou no sentido correto).

Master Boundary

- Coordinate System
U Vector |Defined v

Y Vector | Reverse Direction

OK | Cancel ]

Passo 29: selecionar a face oposta para fazer o “Slave”, devemos clicar com botao

direito e ir em Assign Boundarie>Slave.
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Next Behind

Selection Mode ) Anisotropic Impedance...
Select Objects > Aperture..
Extend Selection # Finite Conductivity..
Go to History Half Space...
Mesciite A Impedance...
Layered Impedance...
View % Linked Impedance...
Edit > Lumped RLC...
Group 5 Master...
Create 3D Component... G
Perfect H...
&5 Assign Material... Radiation
A S o Create Array ... e
fx Prpgress Create Open Region ... Symmetry...
Update Open Region Padding... Fresnel (SBR+)
Assign Boundary > PML Setup Wizard...
Assign Excitation >
Assign Hybrid >
Assign Mesh Operation >
Plot Fields >
Plot Mesh...
Plot VRT >
Copy Image

Passo 30: Para relacionar o Slave 1 com Master 1, precisamos primeiro escolher na
opc¢ao no Master Boundary, “Master 1”7 e depois definir o vetor da mesma forma que
fizemos no Master 1 (nesse caso, o vetor V deve ser reverse para ficar no sentido
correto) e selecionar Next.
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Slave : General Data

Name: |Slavel

Master Boundary: | Undefined >
| Undefined

Master1

Coordinate System

U Vector: |Undefined ¥

V ‘Vector: [~ Reverse Ditection

B Next >
&

Slave : General Data

Name: |Slavel

Master Boundary: | Masterl v
L
~Coordinate System

U Vector: |Undefined nd

Undefined

V Vector: Nev' =

|
Next >

Passo 31: Apés isso, aparecera o menu Phase Delay, onde ndo faremos nenhuma

alteracéo.
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Slave : Phase Delay X

' Use Scan Angles To Calculate Phase Delay

~Scan Angles
Phi: [0 [deg ]
Theta: IO Ideg 3

{Applies to whole model, in the global coordinate system)

L

" Input Phase Delay

Phase Delay IC' ldeg - I

{&pplies to this boundary only)

Use Defaults |

< Back I Finish I Cancel

T T - T T T

Passo 32: pronto, seu Master Slave 1 esta criado.

Passo 33: repetir esse mesmo processo (Master - Slave) para outra face.
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d) Configurando a simulacéo

Passo 34: na caixa Project Manager, selecionar Analysis>Add Solution

Setup>Advanced.
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Desktop View Draw Model Simulation Results Automation
Project Manager a x @ 4@4{3 Model
= mtmnovo B Solids
(-6 novo mtm (DrivenModal) 3 ¥ copper
g 3D Components ¥ FR4_epoxy
"{,fs Model =k g vacuum
.[2F] Circuit Elements E-47 Region
-9 Boundaries 3 CreateRegion
(-2 Exdtations @-l2, Coordinate Systems
. é’ Hybrid Regions -4 Planes
.8 Mesh Operations -2 Lists
i ﬂm— Paste Ctri+V
{7 Optir
~[E Rest | Add Solution Setup 5 O Auto..
B Port g O Advanced..
..M Field
.59 Radi Analyze All
(] Definitior Revert to Initial Temperature
Properties Revert to Initial Mesh
Apply Mesh Operations

Clear Linked Data
Network Data Explorer...
Last Simulation Mesh...

Create Savant Project...

Create EMIT Project...

[

Passo 35: na aba General, por a frequéncia desejada, 0 nimero maximo de passos
para convergir, € o niumero maximo de convergéncia (Maximum Delta S) e clicar em
ok.
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Driven Solution Setup X

General IOptions I Advanced | Hybrid ] Expression Cache | Derivatives I Defaults I

Setup Name Setup1

[V Enabled ™ Solve Ports Only

Adaptive Solutions

Solution Frequency: @ Ssingle (" Multi-Frequences ¢ Broadband

Frequency | 915 ]MHz LI

Maximum Number of Passes 10
¢ Maximum Delta S 0.01|

" Use Matrix Convergence

Use Defaults

HPC and Analysis Options...

Passo 36: clicar na opgao “+” do Analysis e depois em Setupl>Add Frequency

Sweep.
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Project Manager
=] mtmnovo*

=& novo mtm (DrivenModal)*

"@ Model

g% Boundaries
-2 Excitations

= ﬁ Analysis

Results
-1 PortFi

T Field O

5P Radiati 3¢
RRRC0ODESGCRAR0RDLGIICOC0RNY
Properties

Name

Name Setup1 L=
Enabled

Passes 20
Percent R... 20
Delta S 0.01
Solution Fr... 915
Basis Order  First Orc
Max Refin... | 100000
Use Max ...

Use ABC ...

Solver Type Direct &

(L S Aao

HFSS

Message Manager
= mtmnovo (C:/L
- novo mtm

Q So

_ogm

~[@ optime 53 Copy

ﬁ 3D Components

@ Circuit Elements

&F Hybrid Regions
B8 Mesh Operations

Paste

Rename

Delete

Properties...
Disable Setup
Add Frequency Sweep...

Analyze

Submit Job...

Revert to Initial Temperature
Revert to Initial Mesh

Add Mesh Linked Selution Setup
Apply Mesh Operations

Clear Linked Data
Create Quick Report...

Perform FFT on Report ...
Perform TDR on Report ...

Profile...
Convergence...
Matrix Data

Mesh Statistics...

Network Data Explorer...

Projeto de Graduacao

Ctrl+C

Ctri+V

F2
Delete

PN

Passo 37: Nele vocé pode por sua banda de frequéncia de simulacédo, o numero de

pontos calculados e a forma de calcular (discreto, fast ou interpolando).
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Edit Frequency Sweep X
General | Defauits |
Sweep Name:  [ENEES [V Enabled
Sweep Type: IDiscreie L]
-Frequency Sweeps [20 points defined]
Distribution Start End
il Linear Count |750MH2 1500MHz Points 20
Add Above | Add Below | relete Selectior I Preview ... |
3D Fields Save Opti
ittt ol Time Domain Calculation... |
[~ Save Fields {All Frequencies)
c
OK I Cancel I
T

Passo 38: Na barra de ferramenta, clicar na aba Simulation e depois em Validate, se

estiver tudo correto, ndo aparecera nenhum erro.

,"g ANSYS Electronics Desktop 2019 R2 - mtmnovo -

novo mtm - 3D Modeler - [mtmnovo - nove mtm - Modeler]

5 File Edit View Project Draw Modeler HFSS T ow Help
¥) Undo =3 [ EEE Active: Local - Hy P
H g BN - A e
23 Cop Redo A 5 EEAnalysus Config — ]
Save S Setup Sweep  Optimetrics | Validate gnalyze HPC Scheduler Submit Monitor
[ Paste X< Delete v v Options
Desktop View Draw Model Simulation Results Automation
Project Manager J Validate
5@ novo mtm (DrivenModal)* Perform validation check on
H & design setup.
i g 3D Components ,
g Model & FR4_epoxy
[3F] Circuit Elements =4 vacuum
[-E% Boundaries - Region
1.8 Excitations ..} CreateRegion ]
Validation Check: mtmnove - nove mtm »

w novo mim

alidation Check completed.

¥ Design Settings

w# 30 Model

# Boundaries and Excitations
¥ Mesh Operations

¥ Analysiz Setup

¥ Optimetrics

¥ Radiation

Cloze |

Passo 39: clicar em Analyze All

e esperar o resultado.
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& ANSYS Electronics Desktop 2019 R2 - mtmnovo - novo mtm - 3D Modeler - [mtmnovo - novo mtm - Modeler]
B File Edit View Project Draw Modeler HFSS Tools Window Help

H — LJ‘ J EEE Active: Local -

BB Analysis Config

Save Setup Sweep  Optimetrics ValidatejAnalyze HPC
(@ Paste X Delete - v Al Options
Desktop View Draw Model Simulation Results Automation
Pro;ect Manager 2 x @5 Analyze All
Ej @ novo mtm (DrivenModal)* A Simulate all optimetrics and
solution setups.
ﬁ 3D Components

Vocé pode escolher acelerar sua simulagéo, para isso, basta clicar no menu

Progress em Change Priority que ira abrir a opgdo para dar maior prioridade ao

HFSS.
Progress a x
mtmnovo - novo mtm - Setupl: Adaptive Pass #5 - Refining Mesh... on Local Machine - RUNNING
o Abort
Clean Stop
Highest Change Priority >
Above Normal
v Normal

Below Normal

Lowest Priority

Resultado

Passo 40: no Box Project Manager, clicar com botéo direito em Result>Create Modal
Solution Data Report>Retangular Plot.
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Project Manager

-8 novo mtm (DrivenModal)*
é 3D Components
'f,‘} Model
= @ Circuit Elements
[+ g% Boundaries
(-2 Excitations
.. &% Hybrid Regions
..B8 Mesh Operations
£ Analysis

é - }? Setupl

i -~ Sweep

{75 Optimetrics

=
@[ port [ Paste

i Fiele Create Modal Solution Data Report

‘? Radi :
T Create Fields Report
Properties

Desktop View Draw Model Simulation

Create Emission Test Report
Create Monostatic RCS Report
Create Report From File...

[ Delete All Reports
Report Templates

User Defined Solutions...

Create User Defined Solution
Dataset Solutions...
Output Variables...

Link Output...
Update All Reports
Open All Reports

Message Manager
F mtmnovo (C

Create Document

Create Quick Report...
Perform FFT on Report ...
Perform TDR on Report ...

Solution Data...

0]

Tune Reports ...

X!

Browse Solutions...

Clean Up Solutions...

e

Impeort Solutions...

Apply Solved Variation...

Results

Projeto de Graduacao

Automation

2 x [ 565 Model

~
£
£
£
Ctrl+V

-4 Solids
-4 copper
¥ FR4_epoxy
=% vacuum
=4 Region
a CreateRegion

1-l2, Coordinate Systems
v 42 Planes
09 Lists
> Rectangular Plot
> Rectangular Stacked Plot
> Polar Plot
> Data Table
Smith Chart
3D Rectangular Plot
3D Polar Plot
; 3D Spherical Plot
Rectangular Contour Plot
> Smith Contour Plot

Passo 41: Na nova janela que ira4 aparecer, escolher os parametros S11 e S12 em

dB para ver o resultado deles.
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Q Report: mtmnove - novo mtm - S Parameter Plot 1 - (Multiple Traces) X
Satea Trace ] Families I Families Display ]
Solution: . q
ISempl : SWeep L] Primary Sweep: IFreq L‘ IAII _]
Domain: v
Isweep & Xz [V Default | Freq 7|
R Range
¥: ldB(S(Floqueﬁ’ortl,FloquetDort1)), dB(S(FloquetPort P
Category: Quantity: v ] Function:
Variables quetPort1,FloquetPort1) [ EGITES
ables quetPort2,FloquetPort1) ::g—g:g val
! - =
Y Parameter quetPort1,FloquetPort2) ang_rad
Z Parameter quetPort2,FloquetPort2) arg
VSWR cang_deg
Gamma cang_deg_val
Port Zo cang_rad
Lambda
Epsilon dB10normalize
Group Delay dB20normalize
Active S Parameter dBc
Active Y Parameter im
Active Z Parameter mag
Active VSWR normalize
Update Report - Passivity re
Design
[V Real time 4 < >
Qutput Variables... I Options... I New Report Apply Trace I Add Trace I Close

Passo 42: o resultado! Vocé pode clicar com botéo direito no grafico e selecionar
Add Marker para adicionar marcadores em seu grafico.

Name | X Y S Parameter Plot 1 novo mtm A
mi 1.1053 | -14.1. Curve Info
m2 1.1053 | -1.5048

—— dB(S(FloquetPort! FloguetPort1))

] Setup1 : Sweep
5.00

= dB(S(FloquetPort1 FloguetPort2))

] Selupl : Sweep
-10.00 |

-15.00

20.00 |

Y1

-25.00 |
-30.00 |
-35.00

-40.00

45.00 T T
075 028 100 113 125 138
Freq[GHzl
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